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Notices 
Please return your warranty card to Passport immediately. It 

costs you nothing to do so and your name will be placed on our 
mailing list so that we can inform you of all program updates and 
related developments at Passport. Please return your warranty card 
today. (Please allow 6 to 8 weeks for your backup disk) 

This manual is copyrighted. All rights are reserved. No part of this manual 
may be copied, reproduced, translated or reduced to any electronic medium or 
machine readable form without the written consent of Passport Designs, Inc. 

Passport Designs, Inc. makes no warranties either express or implied with 
respect to this manual or with respect to the software described in this manual, its 
quality, performance, merchantability or fitness for any particular purpose. 

Passport Designs, Inc. reserves the right to make improvements or changes 
in the product described in this manual at any time and without notice. All 
specifications are subject to change without notice. 

Master Tracks Pro was designed by Dave Kusek and Don Williams. 
Software written by Don Williams 

Apple IIgs version modified by David Howell 

Original Master Tracks Pro Manual written by Bob Cowart,Steve Cummings 
Dave Kusek, Jay Lee and Lowell Levlnger 

Apple /lgs version modified and edited 
by Denis Labrecque and Banana 

Published by: 
Passport Designs, Inc. 

625 Miramontes St. 
Half Moon Bay, CA USA 94019 

(415) 726-0280 

Edition 1.0 February 1989 
All Manual Contents and Master Tracks Pro™ Software 

Copyright 1989 Passport Designs, Inc. 
ALL RIGHTS RESERVED 

Passport would like to thank the following people for their assistance in the creation 
of Master Tracks Pro: Denis Labrecque, Phil Stone, Perry Devine, Lowell Levinger, 
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Wilcox, Tom Scott, Jay Lee and "Ready,Set,Gol 4". Thank you all very much for all 
of your help. 
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Computer, Inc. Macintosh is a trademark licensed to Apple Computer, Inc. 
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P ASSPORT SOFTWARE LICENSE 

1) Grant of License. In consideration of payment of the License fee, which is a part of the price 
you paid for this product, PASSPORT, as Licensor, grants to you, the LICENSEE, a non­
exclusive right to use and display this copy of Master Tracks Pro™ (hereinafter the 
"SOFTWARE") on a single COMPUTER (i.e., with single CPU) at a single location. 
PASSPORT reserves all rights not expressly granted to LICENSEE. 

2) Ownership of Software. As the LICENSEE, you own the magnetic or other physical media 
on which the SOFTWARE is originally or subsequently recorded or fixed, but PASSPORT 
retains title and ownership of the SOFTWARE recorded on the original disk copy and all 
subsequent copies of the SOFTWARE, regardless of the form or media in or on which the 
original and other copies may exist. This License is not a sale of the original SOFTWARE or 
any copy. 

3) Copy Restrictions. This SOFTWARE and the accompanying written materials are 
copyrighted. Unauthorized copying of the SOFTWARE, including SOFTWARE that has been 
modified, merged, or included with other software, or of the written materials is expressly 
forbidden. You may be held legally responsible for any copyright infringement that is caused 
or encouraged by your failure to abide by the terms of this License. this SOFTWARE is copy 
protected. LICENSEES who return a completed warranty card will receive,direct from Passport 
at no further charge, a backup copy of the program disk for archival use. Under no other 
circumstances does Passport furnish duplicate copies of program disks. 

4) Use Restrictions. As the LICENSEE, you may physically transfer the SOFTWARE from one 
computer to another, provided that the SOFTWARE is used on only one computer at a time. 
You may not electronically transfer the SOFTWARE from one computer to another over a 
network. You may not distribute copies of the SOFTWARE, or accompanying written 
materials to others. You may not modify, adapt, translate, reverse engineer, decompile, 
disassemble or create derivative works based on the SOFTWARE. You may not modify, adapt, 
translate or create derivative works based on the written materials without the prior written 
consent of PASSPORT . 

. 5) Transfer Restrictions. This SOFTWARE is licensed only to you, the LICENSEE, and may 
not be transferred to anyone without the prior written consent of PASSPORT. Any authorized 
transferee of the SOFTWARE shall be bound by the terms and conditions of this Agreement. 
In no event may you transfer, assign, rent, lease, sell or otherwise dispose of the SOFTWARE 
on a temporary or permanent basis except as expressly provided herein. 

6) Termination. This License is effective until terminated. This License will terminate 
automatically without notice from PASSPORT if you fail to comply with any provision of this 
License. Upon termination you shall destroy the written materials and all copies of the 
SOFTWARE, including modified copies, if any. 

7) Update Policy. Passport may create from time to time, updated versions of the 
SOFTWARE. At its option, PASSPORT will make such updates available to the LICENSEE 
who has paid the update fee and returned the Registration Card to PASSPORT. Only 
registered owners of Master Tracks Pro are entitled to purchase later revisions of the program 
for an update fee. Send your current program disk(s) along with the update fee directly to 
Passport Designs, Inc. Attention: Software Update at the address listed on the back cover. 

8) Miscellaneous. This Agreement is governed by the laws of the State of California. 
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DISCLAIMER OF WARRANTY AND LIMITED WARRANTY 

THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS 
(INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" 
WITHOUT WARRANTY OF ANY KIND. FURTHER, PASSPORT DOES 
NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE, OF THE 
SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. THE 
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN 
MATERIALS ARE DEFECTIVE YOU, AND NOT PASSPORT OR ITS 
DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES, ASSUME THE 
ENTIRE COST OF ALL NECESSARY SERVICING, REP AIR OR 
CORRECTION. 

Passport warrants to the original LICENSEE that the disk(s) on which 
the SOFTWARE is recorded is free from defects in materials and 
workmanship under normal use and service for a period of ninety (90) days 
from the date of delivery as evidenced by a copy of the receipt. Further, 
PASSPORT hereby limits the duration of any implied warranty on the disk to 
the period stated above. Some states do not allow limitations on duration of 
an implied warranty, so the above limitation may not apply to you. 

PASSPORT's entire liability and your exclusive remedy as to the disk(s) 
shall be replacement of the disk that does not meet PASSPORT's limited 
warranty and which is returned to PASSPORT with a copy of the receipt or 
warranty. If a failure of the disk has resulted from accident, abuse or 
misapplication, PASSPORT shall have no responsibility to replace the disk(s) 
or refund the purchase price. Any replacement disk(s) will be warranted for 
the remainder of the original warranty period or thirty (30) days, whichever is 
longer. 

Defective media returned by the LICENSEE during the warranty period 
will be replaced without charge, provided the licensee has signed and 
returned the warranty registration card enclosed with the product, and 
provided that the returned product has not been subjected to misuse, damage, 
or excessive wear. Following the initial ninety-day warranty period defective 
media will be replaced for a replacement fee - contact PASSPORT for details. 
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Welcome to Master Tracks Pro for the Apple figs. Master 
Tracks Pro, from Passport Designs, Inc. is a powerful and 
versatile 64 track MIDI sequencer for the Apple figs. Master 
Tracks Pro was designed from the ground up at Passport to 
offer you the most advanced, state-of-the-art multi-track MIDI 
sequencer available today. 

Complementing a full line of software products for musicians, 
Master Tracks Pro represents Passport's commitment to 
offering serious musicians the composition and performance 
features they want most. 

Master Tracks Pro gives you a free-form approach to 
composing music. Using as many as 64 separate MIDI tracks, 
you can create, combine or edit musical phrases of any 
length, just as you would use a word processor to write a 
document. You can enter these musical phrases into the 64 
track MIDI recorder either by simply playing your MIDI 
equipped instrument in real or step time, or by entering 
individual notes from the computer usinQ the mouse. Then 
you can easily edit, rearrange and combine the tracks in a 
variety of ways to build complete songs. The pr09ram 
provides real-time and step-time input, song editing, note 
editing, and more in one package. 
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features Master Tracks Pro includes features which let you do the 
following: 

• Control the sequencer using an on-screen control panel 
that looks like a tape recorder transport control. Just 
click on Play, Record, Pause, Stop, Rewind or 
Fast-Forward to move instantaneouslY from measure 
to measure. 

• Set the meter, tempo and beat independently for each 
measure. 

• Record all MIDI events on the 16 possible MIDI 
channels simultaneously, including key' velocity, 
after-touch, sustain, modulation and pitch wheel 
changes and program changes. 

• Apply automatic and musically accurate error correction 
to your music, compensating for imperfect playing 
technique. 

• Merge, delete, transpose, repeat and copy individual 
tracks, or selected portions of tracks. 

• Change the note velocities, continuous MIDI data, note 
durations, key, tempo, or meter for whole tracks or just 
selected regions of a track or tracks. 

• Change playback tempo instantly or gradually over time. 

• Visually edit your compositions in a window that displays 
all MIDI events. Change a note's pitch by dragging it to a 
new position. Step input using the mouse or MIDI 
keyboard with selectable duration, velocity, articulation 
and MIDI channel for each note. 

• Graphically plot and alter pitch bend, aftertouch, key 
pressure, modulation, controllers, tempos and program 
changes. 

• Set markers anywhere in a piece and easily jump to 
those locations for easy editing. An auto-rewind feature 
can be set to quickly "rewind" your composition to a 
given point for effortless recording of multiple takes of a 
single track, or of subsequent tracks. 

• You can incorporate your MIDI music into Rrofessional 
audio and video productions utilizing MIDI Song Position 
Pointer and external SMPTE synchronizers. 
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Master Tracks Pro is similar to a fancy tape recorder, only much 
more capable. Like a multi-track tape machine, Master Tracks 
Pro lets you record one track of music at a time, playing them 
back later as an ensemble. You can even edit each track 
individually to make changes or fix mistakes - a feat which is 
impossible with audio tape recorders. And with a total of 64 
tracks available at any given time, Master Tracks Pro offers 
much greater flexibility than do most tape machines. 

As you may know, there are many MIDI sequencers available 
today. So, what makes Master Tracks Pro different? To begin 
with, Master Tracks uses dynamically allocated tracks. This 
means that the various tracks in a given musical piece can be of 
any length, and that length is alterable. Many other sequencers 
require all tracks to be the same length. Master Track Pro does 
not. 

Secondly, Master Track Pro allows you to alter discrete portions 
of a track or tracks after you've made a recording. This is similar 
to the ability to mark and alter block of text when using a word 
processor. Regional selections are made in the same way with 
Master Tracks Pro as in other Apple figs and Macintosh 
programs such as Macwrite or Macpaint. After marking a block 
of music in Master Tracks Pro, you can then modify the 
selected notes or MIDI events in a wide variety of ways. 

You record your musical sequences, one track at a time, either 
in real time (as you play on a MIDI-equipped keyboard), or note 
by note using the mouse or midi keyboard (step entry). For step 
entry of notes, Master Tracks Pro provides a graphic step editor 
that lets you see each note on the computer's screen as you 
enter it. The step editor also lets you precisely edit each note or 
other musical event after it has been recorded, whether you've 
used real time o'r step entry to record your music. 

In addition to editing individual notes, tracks as a whole can be 
further edited, and they can be mixed together with other tracks 
in a variety of ways to form compositions of various lengths -
even very long pieces. Using the Master Tracks Pro's clipboard, 
you can cut and paste sections of one piece into another piece 
to quickly create songs based on a number of existing 
sequences. 
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the interface Master Tracks Pro follows well established traditions for the 
Apple figs when it comes to using the keyboard and mouse to 
control the program. If you have used your figs even a little and 
know your way around a few other figs programs, you'll be 
able to learn Master Tracks Pro very qUickly. 

Master Tracks Pro's many program functions and commands 
are organized logically into a number of different windows 
where you work with your sequences. There are six main 
windows: 

~ Transport window - where you control your MIDI tape 
deck by clicking on Play, Stop, Fast-Forward, etc. 

~ Track Sheet window - where you record and playback 
your tracks. 

~ Conductor window - where you control tempo, meter 
and beat settings. 

~ Song Editor window - where you display, cut, copy, 
paste, and regionally alter tracks. The structure of a 
sequence is displayed and edited in units of measures. 

~ Step Editor window - where you display the individual 
notes in a track. Graphic display of note data lets you see 
exactly what you are doing. The notes are displayed on a 
piano roll, from left to right. 

~ MIDI Data windows - where you display and edit a 
graphic plot of pitch bend, channel pressure, key 
pressure, modulation, controllers, or program changes. 
There are seven MIDI Data windows: 

Pitch Bend 
Channel Pressure 
Key Pressure 
Modulation 
Controllers 
Program Change 
Conductor Edit Window 
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between 
windows 

figurel. 1 
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All of the main windows described above include menu 
selections at the top of screen, and various icons located on the 
screen which are used in the editing or record/playback 
operations. These are explained in detail in their respective 
chapters of this manual. 

All of the windows and their associated commands are 
accessed via the menu bar at the top of the figs's screen. You 
simply point to the name of the window or command you want, 
press the mouse button and pull the mouse toward you. Then 
highlight the selection you want from the menu, release the 
button, and the program does the rest. 

Master Tracks Pro lets you have several windows "open" and 
on the screen at the same time. However, at any given time, 
there is only one active window. The active window is the one 
you are working on at the time. To activate a different window 
you simply point to it and click the mouse. Additionally, you can 
move windows around to convenient locations on the screen 
and size them according to your preferences. 

Once you have the windows set up the way you like, you can 
then easily switch between them. It's a little like setting up your 
desktop or work area to have everything in a convenient 
location. A setup we've found useful lines up the Song Editor 
and Sequencer windows so that tracks line up. The transport 
control sits at the bottom of the screen, as you see in Figure 
1.1, as does the conductor window. 

• It File Edit Chonge Windows LRyout Goodies 

10 Song Editor 0~ 

Troe ~ First Them!- ". Bass Thtmto 



1-6 Master Tracks Pro 

using 
command 

keys 

The window's menu items all have keyboard equivalents, too. 
The three main Master Tracks Pro windows can be accessed 
by pressing Command-1, 2, or 3. 

Aside from the menu and window selection techniques 
described above, there are some shortcuts you may want to 
use. The Command key performs certain operations, such as 
Copy, Paste, and Cut in addition to using the menu selections 
directly. 

To use these commands, you press the Command key and 
the corresponding key at the same time. Sometimes this is 
the first letter of the command. Having two ways to select and 
execute commands allows flexibility for individual preferences 
and situations. You may find that you prefer using the menus 
while you are learnin~ the program, but that you can get 
thin~s done faster usmg the command keys once you're more 
familiar with the program. If you have questions about this or 
other Apple //gs specifics, consult the user's guide supplied 
with your computer. (see the Summary of MT Pro keyboard 
commands in Chapter 14) 

Now proceed to Chapter 2 to connect up your hardware and 
install your program. 



Before you begin using Master Tracks Pro, you will have to: 

~ Insure that your Apple figs has a minimum of 1 meg total 
memory (see the following section on hardware 
requirements). 

~ Hook up your MIDI interface to your Apple //gs (refer to 
your interface owners' manual) . 

~ Connect your MIDI cables between your synthesizer and 
computer (see the diagrams at the end of this chapter). 

~ Make a working copy of the Master Tracks Pro disk or 
install the software onto your hard disk (if you are using 
one) see below for details. 

~ Format ~ one blank disk to record your songs before 
running Master Tracks Pro. You can not format a disk from 
within the program! 

This chapter explains how to do these procedures. Please take 
the time to read this chapter so that you can begin using Master 
Tracks Pro quickly and without any unnecessary headaches. 



2-2 Master Tracks Pro 

copy protection 

customer 
service 

Passport Customer Protection Policy 

Master Tracks Pro is copy protected. That means it's nearly 
impossible for you to make multiple copies of the disk and the 
Master Tracks program. Believe it or not, there are some people 
out there who paid thousands of dollars to monolithic companies 
for their synthesizers and computers, but think nothing of 
stealing a relatively inexpensive software program from a 
company like us. There's no foolproof cure for this kind of 
stupidity that we can think of, except to try preventing it by copy 
protecting our disks. Unfortunately, this makes things more 
complicated for both you and for us. It's an extra job for us to 
make our disks difficult to duplicate, and you have the hassle of 
being limited in the number of backup copies you can make for 
yourself in case your disk is somehow ruined.To share these 
programs with friends or to use them on multiple computers or 
to violate the software licensing agreement in any way is a 
criminal act. It's not just slightly criminal, it's as if you broke into 
our offices and stole cash from our safe. The end result is the 
same. We end up getting ripped-off for something that a lot of 
people put a tremendous amount of time and effort into. 

We trust that you, as a professional, will not help others steal our 
handiwork. It is in your own best interest to ensure that the 
Master Tracks Pro venture remains profitable. We are 
committed to constantly improving Master Tracks Pro and to 
providing you with a high level of customer support. By not 
giving Master Tracks Pro away to others you will be helping us to 
serve you better. 

In order to protect your investment in Master Tracks Pro we 
have instituted a few procedures that we hope will discourage 
illegal copying and use of this software. Please be assured that 
Passport intends to protect its rights in Master Tracks Pro to the 
fullest extent permitted by law. 

The Master Tracks Pro system consists of several highly 
complex and constantly evolving programs. It is very likely that, 
at some point in time, you will need a program update or some 
other form of assistance. For this reason it is vitally important 
that you return your warranty registration card and become a 
registered owner. Only registered owners will be eligible for 
customer service. Sending in your warranty card also places 
you on our database to receive new product and update 
announcements. 
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getting a free 
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Send in your warranty registration card today ! 

First of all, If you return your warranty card enclosed in the 
package, you will receive a FREE BACKUP DISK from 
Passport. This backup disk can be used as your working 
program disk if you so choose. If you NEVER store any data 
files on your program disk it should last you quite a long time. 
Replacement backups can be purchased from Passport -
contact customer service for more details. 

Keep your original disks in a safe place! 

Always keep the original disks in a safe place since they must 
be returned in order to receive any future updates. Also, you 
should have both your original disks and your manuals handy 
when calling in for customer service. Our personnel may ask 
you a few simple questions to verify that you are an 
authorized user. 

By following these simple procedures you will ensure that 
Master Tracks Pro remains reasonably priced and that the 
entire Master Tracks Pro system will continue to evolve. 

You can playa part in the evolution of Master Tracks Pro. We 
are extremely interested in your feedback on the program 
and your suggestions for future enhancements. The current 
version of Master Tracks Pro is the result of suggestions and 
comments from hundreds of users just like you. Let us know 
what you want to see next and we will try and implement your 
ideas. 

Remember, you have not just purchased a disk and several 
hundred printed pages, you have invested in the expertise of 
all the people involved in the entire Master Tracks Pro project. 
Thank you for your support! 
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~Hardware Master Tracks Pro requires an Apple JIgs with at 
requirements least 1 meg of total memory! The most common 

configuration will be a standard 256k Apple Jigs with an extra 
1 meg memory card installed, giving you a total of 1.25 meg -
contact your local Apple dealer for more information. MT Pro 
also requires that you have the IIgs system ROM ver.B 
installed in your IIgs motherboard. Consult your Apple dealer 
for details. 

memory usage 

Interface 
Installation 

hooking 
up your 

MIDI cables 

Master Tracks Pro works with all 1 mHz passive MIDI 
interfaces such as the model MH-01 m MIDI interface from 
Passport. Simply install your interface following the 
instructions supplied with it to either the modem port or the 
printer port (please be sure to also set the proper port in the 
Master Tracks Pro software - see chapter 13 "MIDI Setup" for 
more details). 

The next step is to hook up your MIDI cables. The exact 
configuration of cables will vary depending on your particular 
arsenal of equipment. However, two general schemes are 
shown in Figure 2.1. You will need at least two cables - one 
for MIDI-In and one for MIDI-Out. The first cable goes from 
MIDI-Out on your synthesizer or keyboard controller to the 
MIDI-In connector on the MIDI interface connected to your 
Apple figs. The second one goes from MIDI-Out on the 
interface to MIDI-In on your synthesizer. 

You may want to hook up other MIDI cables too, if you have 
additional synthesizers and sound modules. Some interfaces 
have additional sockets for such connections. alternately, you 
may chain together a number of synthesizers via any 
MIDI-Thru connectors which your synthesizers have. To do 
this, you simply run a cable from your main synthesizer's 
MIDI-Thru socket to the second synthesizer's MIDI-In 
socket, and so on. Refer to the illustrations on page 2-6 if you 
are in doubt about cable hookups. 
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Master Tracks Pro can simply be run from the original 
program disk provided. However, we recommend that you 
make a "working copy" to ensure that you have a backup in 
case anything goes wrong with the copy. 

You should have at least one formatted blank disk to store the 
songs you will be creating - it is a good practice !JQtto save 
song files onto your program disk. The Apple jigs does not 
allow Master Tracks Pro to format a disk while running. 
(Refer to your fIgs manual if you are unsure how to format a 
blank disk) 

To make a working copy of the program on a floppy disk, copy 
the program disk onto a formatted blank disk using the finder 
or a copy utility. You can then boot with the copy but you must 
insert the original master disk when prompted to. 

Use this backup as your working disk and keep the 
original program disk in a safe place to use as a 
spare in case anything happens to your working 
copy. 

To install the program onto a SCSI ("scuzzy") hard disk (such 
as the DataFrame), simply boot your system off the hard 
disk, insert the original program disk into the Apple //gs and 
double-click on the Master Tracks Pro icon. The protection 
program built into Master Tracks Pro will automatically sense 
the presence of the hard disk and ask you if you wish to install 
the program on a hard disk volume. 

If you do not wish to install Master Tracks ProTM on your hard 
disk, select EXECUTE ORIGINAL and the program will boot 
off of the 3.5 inch disk. 

If you select install, you will be presented with a dialog box 
showing the contents of your program disk. Click on DISK to 
display the contents of your Hard Disk and then click on 
INSTALL. You can install it using a different filename if you 
wish. 
If the program does not give you the prompt, then it may not 
work on your hard disk. If you have trouble installing the 
program on your hard disk make sure that the program is not 
locked on the original program disk or that the program disk is 
not write protected. 
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removing a You can only install the program twice on a given hard disk. 
hard disk install However, you can "deinstall," or remove, a copy of the 

program from the hard disk back onto the original floppy in 
order to move it to another hard disk. 

modifying your 
system folder 

To remove your installed copy from your hard disk back onto 
the original floppy, hold down the OPTION key while you 
double click the Master Tracks Pro™ icon on the original 
program disk. A dialog box will offer you the chance to select 
REMOVE. Do just that. Click on DISK and then open the 
folder containing your installed copy. Select the copy and 
click REMOVE. 

You can then Execute Original, re Install the copy, or return to 
the Finder. If you are using a Macintosh SE with built in hard 
drive, you must boot from the program disk for the installation 
procedure. 

If you are using a system other than the one provided with 
your Master Tracks Pro disk, you must insure that you have 
the correct MIDI device drivers installed. You must have a 
DRIVERS folder included in the SYSTEM folder of your 
startup disk (either floppy or hard disk). There are two files 
which must be present in your DRIVERS folder before MT Pro 
will run properly. 

These files are named APPLE.MIDI and CARD6850.MIDI. 
You will find these files included in the Drivers folder of your 
System folder which is included on your Master Tracks Pro 
disk. Copy these files into your ICONS folder. 
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To start up Master Tracks Pro, follow these instructions: 

1. Turn on your MIDI equipment, then your computer in 
the normal manner. 

2. If you are running the program from a floppy disk, make 
sure you insert your Master Tracks Pro working disk. 

3. Double-click on the Master Tracks Pro icon (or on the 
name Master Tracks Pro if you are viewing your 
directory by name rather than by icon). 

4. Insert the original master disk ("key disk") when 
prompted to.This will load the program and display the 
Track Sheet window, Transport control, Conductor and 
Menu bar. 

5. Eject the master disk and insert a formatted blank data 
disk. You're ready to go! 

Now move ahead to Chapter 3 to quickly learn how to record 
and playa tune with Master Tracks Pro. 
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running the 
program 

This Chapter walks you through the basics of recording, 
editing and playing back a tune using Master Tracks Pro. 
Only the basics are described here, but it's enough to get 
you going. We certainly recommend your reading the rest 
of this manual to take advantage of the full capabilities of 
the program. 

1. Begin by making sure your MIDI interface and cables 
are installed properly (see the section on Installation), 
and then turn on your MIDI instrument (it's best to turn 
on your instruments before you turn on the Apple figs). 
You should also have a blank, formatted disk to save 
your sequences on (see chapter 2). 

2. Turn on your Apple figs, put your Master Tracks Pro 
disk in a disk drive, and wait until the system boots and 
the Finder window appears on the screen. 

3. Double click on the Master Tracks Pro icon in the 
window to start the program.The Master Tracks Pro 
main screen will appear, with the Transport, Track 
Sheet, Song and Conductor windows on the screen as 
you see in Figure 3.1. See chapter 2 for additional 
startup information. 

4. Look at the Transport window at the bottom of the 
screen. This window contains the controls you use for 
starting, stopping, fast forwarding and rewinding. It also 
has a pair of counters to show you where you are in the 
sequence, and a number of other controls on the right 
side of the window. 
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figure 
3.7 

recording 
a track 

5. Notice that the Auto control is highlighted in inverse 
video, indicating that it is on. When Auto is on, the 
sequence automatically rewinds to its start point as 
soon as you stop playing or recording. 

6. Look at the Track Sheet window at the upper portion of 
your screen. Click on the Record box (the one labeled 
Rec) in the first track of the sequence. Be sure that a 
solid black circle appears in the field, indicating that the 
track is activated and is ready to record. 

7. Get your MIDI instrument ready to record your first 
track, and set it to send and receive on MIDI channel 1. 
Start the recorder by clicking on Record in the 
Transport window, or by pressing Enter (or Return) on 
the Apple fIgs keyboard. 

8. Play some music. When you're finished playing, click on 
Stop in the Transport window, or simply hit the 
spacebar. 

Notice that the counter immediately returns to measure 1, 
beat 1 as soon as you stop the sequence, because Auto 
(auto-return) is on. Notice also that in the Sequencer window, 
the Play box for the track you've just recorded now contains a 
solid black triangle, meanmg that it has been activated for 
playback. 
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1. To play back your first track, click on the Record box 
again to deactivate the track for recording, setting it to 
Play mode. 

2. Click on Play in the Transport window, or press the 
spacebar on the Apple figs keyboard (see Figure 3.2). 

3. To stop playback, click on Stop in the Transport window 
or press the spacebar again. 

1. To record another track, go back to the Track Sheet 
window and activate the second track for recording by 
clicking in its Record field. You'll see the solid black 
circle appear in the field. 

2. The rest of the process is identical to the steps you used 
to record your first track: just click on Record or press 
the Enter key to start the recorder. You'll hear your first 
track play while you record. When you're through, click 
on Stop or press the spacebar to stop the recorder. 
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playing both By now, it's probably obvious what you have to do to play both 
tracks tracks of your two-track recording. Simply click on track 2's 

Record box to deactivate it, and start the playback by clicking 
on Play or hitting the spacebar. 

figure 3.3 r ~ File Edit Chonge Windows loyout Goodies 

Tempo. 120 Bar But Clock 

I¢IH~iiliili!1 Iliiilill!iIIlil91 1-='-.: c:"~:O_0-l0 
~ J=120 

naming your Master Tracks Pro lets you give each track a name for easy 
tracks reference. Typical names might be "Bass", "Horns", "Lead 

licks", etc. 

1. To name your first track, click over the track name field 
for the track. A small window pops up, as you see in 
Figure 3.3, and you can now type in the name you've 
chosen. When you're through, click on OK or press 
Return. 

saving Master Tracks Pro works like any other Apple Jigs program 
the sequence when it comes to saving your work on disk. When you're 

on disk ready to save: 

1. Choose Save as ... from the File menu. 

2. As soon as you choose the Save as ... command, Master 
Tracks Pro will present a dialog box that lets you name 
your sequence. You may also select a different Drive or 
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Eject the current disk. Since there is very little space left 
on your MT Pro program disk, Eject it and insert a 
formatted blank disk or data disk. Now click on "Disk" 
and then type in the name you've chosen, and click on 
OK or press Return. The file will be saved. (After you've 
saved a file once, you won't need to enter the name 
again-it will be saved automatically every time you 
choose the Save command. Remember, however, that 
the old file of the same name will be overwritten!) 

Now that you have saved your first sequence, Open the file 
on your Master Tracks Pro original disk entitled 
BACH.INVENTION. You can make changes on groups of 
measures from the Song Editor window. 

1. Choose Song Editor from the Windows menu to call up 
the window. A graphic representation of the sequence 
will appear in the window, with each track visible as a 
row of rectangular boxes. Each box represents a 
measure. If the measure contains any MIDI data, it will 
appear as a solid black box. If it is entirely empty, the 
box will appear "hollow," in outline. Both are shown in 
Figure 3.4. 

figure '. File Edit 
3.4 
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figure '. File Edit 
3.5 

Let's say your sequence has a standard A-B-A pattern, and 
you want to use the edit commands to repeat the B section. 

2. First, copy the B section to the Master Tracks Pro 
clipboard, a temporary holding area for MIDI data 
during the editing process. Click on the first measure in 
the B section in Track 1 and drag the mouse diagonally 
(with button still down) across both tracks until the 
entire B section is highlighted, as in Figure 3.5. This 
selects that range of measures. 

3. When all the measures in the B section are selected, 
choose Copy from the Edit menu. During the brief 
pause, Master Tracks Pro copies the selected 
measures to the clipboard. 

4. Next we need to insert some new measures in the 
sequence to make room for the repeat of the B section. 
Click on the space in Track 1 between the last measure 
of the B section and the first measure of the second A 
section. You'll see a blinking vertical cursor appear at 
this insert point. 
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5. Now choose Insert Measures from the Edit menu. 
When the dialog box pops up, as in Figure 3.6, type in 
the number of measures that the B section contains. 
Click on OK or press Return when you've made your 
entry, and notice that new empty measures will appear 
in your sequence as hollow boxes. 

Insert @::J measure(s) before measure 15. 

@RII trocks 
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6. Now you're ready to add the B section data into these 
new measures. Without changing the insert point, 
choose Paste from the Edit menu. The entire contents 
of the clipboard will be emptied into the new empty 
measures in both tracks of your sequence, and you've 
just created a repeat of the B section. 
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7. You can now click on the Play button or press the 
space bar to hear your revised sequence. 

Please take the time to read the following sections 
thoroughly - they describe in detail the extensive features of 
this program (and may save a customer service call!) 



the transport 
and conductor 

windows 

Master Tracks Pro is designed to work much like a 
conventional multi-track tape deck. Although a sequence is 
stored in the Apple //gs' memory instead of on tape, you still 
need controls that let you play, record, fast forward, rewind, 
and stop the sequence. You also need a counter to tell you 
where you are in the sequence. The Transport window is 
where Master Tracks Pro provides these features. 
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T.nwo = 160 

I¢ I~i!i!imill] l:!!mlim!;il91 

~ J=160 
CI..rnnt Timt 
000:00:0 

untitled 

The center portion of the Transport window has six screen 
"buttons"- play, record, fast forward, rewind, pause and 
stop. They function just as their counterparts on an actual 
tape deck. To "press" one of these buttons, you just click on it 
with the mouse. 

Alternately, you can control any or all of these transport 
functions from your MIDI Keyboard. See the section on the 
Keyboard command in Chapter 13 for instructions on how to 
select the keys you want to use for transport controls. You 
can also execute the play, record, and stop functions from 
the Apple figs keyboard. 
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Here's how each of these transport functions works: 

play Plays the sequence beginning at the point currently indicated 
in the counter. Pressing the spacebar on the Apple figs 
keyboard also starts playback. Before starting playback, 
remember to be sure that the MIDI channels set for each 
track agree with the instrument(s) that you are using to play 
the track. Also, the track or tracks you want to hear must be 
play enabled (see selecting which tracks play on page 4-5 ). 

record Click on the Record button to start recording on the track 
selected on the Track Sheet window, beginning at the 
location in the sequence indicated in the Measure Counter. 
Pressing the Enter key (or Return)on the Apple figs keyboard 
will also start the recording. A track must be selected before 
you start recording, or the command will not function. See 
selecting which tracks record on page 4-5 for details. 

rewind 

fast forward 

stop 

all notes off 

Each time you record on a track, the new data is recorded 
over any data previously recorded. You can have Master 
Tracks Pro start recording at any point in the sequence, and 
existing data in the track before that point is left intact. 
Likewise, any data in the remainder of the track past the point 
at which you stop recording remains untouched. 

Click on rewind to .rewind the sequence a measure at a time. 
You can also move instantly to the beginning of the sequence 
by double clicking on this control. Control A will also rewind 
the sequence to the top if the Song, Step,Transport or any 
MIDI Data windows are active. 

Click on the fast forward control to advance through the 
sequence a measure at a time. Double click to move instantly 
to the end of the sequence. Control Z will move to the end of 
your sequence if the Song, Step,Transport or any MIDI Data 
windows are active. 

ASJOU'd expect, clicking on the Stop button stops playback 
an recording. If the Auto function is on, the sequence 
automatically rewinds to wherever you last started playback. 
You can also use the spacebar on the Apple figs keyboard to 
stop the sequence during playback or recording. Pressing the 
spacebar, or clicking Stop, sends an "all notes oW command 
to all MIDI channels. 

pause Clicking on the Pause button pauses both play and record. 
When you click again, the sequence resumes playing or 
recording. 
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On the left side of the Transport window are two counters that 
let you locate your current position in the sequence. The 
Measure Counter at the top left displays the position in the 
sequence in measures, beats, and individual clock ticks 
(Master Tracks Pro's internal clock divides a quarter note into 
48 parts (ticks). See the section on the Conductor window for 
more information about sequence timing). 

You can move to any location in the sequence directly by 
clicking on the measure, beat or clock field in the Measure 
Counter, and typing in the number from the Apple figs 
keyboard. 

The Current Time Counter shows the actual time (in minutes, 
seconds, and tenths of seconds) that has elapsed since the 
beginning of the sequence. As you'd expect, playing the 
same sequence at different tempos will result in different 
current time readings. 

Current Time 
000:00:0 

untitled 

other transport At the right side of the Transport window are a variety of 
window settings miscellaneous controls: 

wait for MIDI 
keypress 

auto 

~ Key Clicking on the Key control highlights the control. 
Now when you select play or record Master Tracks Pro 
will wait until it detects that a MIDI key has been pressed 
and released before it begins recording or playing. 

~ Auto Turn on Auto by clicking on it. When Auto is on, 
whenever you stop the sequence it will automatically 
"rewind" to the point where playback started last. 
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count in 

metronome 

MIDlthru 

Punch In/Out 

~ Count In When this control is on, Master Tracks Pro's 
metronome counts off one measure according to the 
meter set in the Conductor window before starting to 
play or record. 

~ Metronome Clicking on Metronome highlights the 
control, and turns the metronome on. Now, when you 
play or record a sequence, you'll hear a click tone on 
each beat of each measure over the Apple figs internal 
speaker for the entire length of the piece. The click tone 
is also available through the speaker jack at the back of 
the Apple figs. 

~ MIDI Thru This control is used when you're recording 
from a master MIDI controller, that doesn't produce 
sound itself, or when you want to use one synthesizer 
to control another while recording. Click on MIDI Thru 
to highlight it. With MIDI Thru on, the MIDI data you 
send to the Apple figs will be passed out the MIDI Out 
port on your Apple figs's MIDI interface. All the data will 
be sent out on the MIDI channel indicated in the MIDI 
Thru box. If no channel is assigned ("0"), all data will 
pass thru on it's incoming channel(s). The Thru 
channel follows the channel set for any track set to 
Record in the Track Sheet Window. 

~ Punch Click the Punch button to activate the Punch 
In/Out record mode. There are two ways to select the 
Punch region. Double click the Punch button and a 
dialog box appears, letting you assign the In and Out 
locations. The second way to select a region is to use 
the mouse in the Song, Edit or Midi data windows. Any 
area selected for editing will be the Punch region. After 
selecting "OK" you may start the transport from any 
point by clicking Record, pressing Enter or using your 
MIDI keyboard. Recording will start and end 
automatically for the selected region. 

Punch Settings 

Bar Beat Clock 

Inot EJ[]~ 

Outot ~[J~ 

OK ( Concel l 
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The Track Sheet window is the display window for some of 
the most basic information about your sequence. It lists the 
64 tracks available in Master Tracks Pro, and allows you to 
select the tracks that will record or play. You can also select a 
MIDI channel for all data in each track, choose a name and 
an initial MIDI program number for the track, solo single 
tracks, and loop tracks independently. 

If the Track Sheet window is not already on your screen, or if 
it is hidden by other windows, you can activate it by choosing 
it from the Windows menu, or by pressing Command-1 on 
the Apple figs keyboard. 

Track Sheet window basics are simple. To change any item in 
the window, just click in the box of the item you want to 
change. 

For settings that are either on or off, an icon in the box 
indicates the setting is on, while an empty field means that 
the setting is off. 

For parameters that require you to enter text or numeric 
values, a Change Value window will pop up, allowing you to 
enter the information. 

A "0" in the channel or program columns indicates that the 
function is OFF for that track. MIDI data will play out on the 
channel(s) on which it was received. 

You can select any combination of tracks in your sequence to 
play back. Other tracks that are not selected will not play, 
even if they contain MIDI data. 
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selecting Click in the Play box of each of the tracks that you want to 
which select for playback. The triangular play icon 6 appears in each 
tracks track's Play box to show that the track is selected, and will be 

play played when you start the sequence. In addition immediately 
after you complete a recording on a track, that track is 
automatically set to playback. 

selecting 
which 
tracks 

record 

To turn playoff for that track, click in the box again. The play 
icon will become hollow, and the track will not be played when 
you start the sequence. Tracks can be muted and turned 
back on during playback and recording. 

Only one track can be selected for recording at a time. To 
select a track for recording, click in the Record box for that 
track. A solid black circle appears in the Record box to 
indicate that the track is selected. When you start recording, 
all incoming MIDI data will be recorded on that track (unless 
you are using the Record Filter - see chapter 13). 

To deactivate a track for recording without selecting another 
track, just click on the Record column for that track again. The 
record icon disappears. 

soloing The Solo command gives you an easy way to play back a 
tracks single track or a few tracks without having to individually 

deactivate the play box on all the other tracks. Then, when 
you want to hear more tracks again, you only have to turn off 
Solo on the selected tracks. 

To select a track for soloing, just click on the track's Solo box. 
You'll see a solid black diamond pop up in the box. To turn 
solo off, just click on the box again. Any number of tracks can 
be soloed at a time. Option click on any solo box to unsolo all 
tracks. 

naming tracks Each track can have a name, which serves as a memo you 
can use to describe the music in the track or to remind 
yourself of which instrument and/or sound you've chosen to 
play the track. These track names are saved permanently 
with the sequence file when you store it on a disk. 

Click on the Name box in the track you wish to name (you can 
name any track, even if it does not contain MIDI data). A 
dialog box pops up and asks you to type in the name of the 
track. You can use any combination of characters you wish. 
When you're finished, click on OK or press Return to 
complete your entry. Or click on Cancel if you want to return to 
the Track Sheet window without making any changes. 
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selecting The Channel box contains the current MIDI channel setting 
the MIDI for playback of the track. To use this feature, you need a little 

playback background on the way the program handles MIDI channel 
channel information. 

Master Tracks Pro supports multiple-channel tracks. You can 
record on any combination of channels within a track, and you 
can freely mix data from one track to another, retaining all the 
original channel data. 

If you enter a channel number of 1-16 in the Channel box, all 
data in the track will be played on that channel. On the other 
hand, a channel value of 0 plays back the track exactly as it is 
stored in memory, on the same channel(s) it was received on. 

To change the channel, click in the Channel box. A small data 
entry window will pop up. Type in the number of the channel 
you want for the track, or use the arrow controls to change the 
setting. When the channel number is correct, click on OK or 
press Return to enter it and return to the Sequencer window. 
Of course, you can click on Cancel to leave the setting as it 
was. Thru follows the channel for any track set to record. 

setting A program is the MIDI term for a MIDI device's programmed 
the setup, stored in the memory of the device. On a synthesizer, a 

program program may be equivalent to a "patch",voice or sound. On a 
number drum machine, a program may select a particular pattern, 

and on a MIDI effects device it may select a configuration 
setting with pre-programmed values for all the parameters on 
the device. Each program has a number, and when a MIDI 
program change message is sent to the device, the device 
responds by switching to that program number. 

Master Tracks Pro allows you to record program changes at 
any point in a track, and to enter as many program changes 
as you like via the Program Change window accessible on the 
Windows menu. On the Track Sheet window, however, the 
number in the Program field refers only to the program 
number that Master Tracks Pro will send when the sequence 
begins playing from the start of the first measure. 

If the program setting is 0 ( the default), no program change is 
sent when the sequence begins---your instrument will remain 
set to whatever program it's already on, until it receives a 
program change from the sequence data. Likewise, if you 
start the sequence from some point other than the very 
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beginning, the program indicated in the Program field is not 
sent, and only program changes stored in the sequence data 
will be sent. 

To change the program setting, click on the Pro~ram field for 
the track you want. When the small data entry Window pops 
up, type in the number of the program you wish,click on the 
arrow keys to raise or lower the value or press the 
appropriate program # on your MIDI keyboard. When the 
number is correct, click on OK or press Return to enter it and 
return to the Sequencer window, or click on Cancel to return 
without entering the change. The program change will be sent 
out whenever you click OK or press Return even when a 
sequence is playing. 

looping Each track in a Master Tracks Pro sequence can be 
a track independently looped. When the sequence gets to the end of 

a track, it plays the track over again from the beginning, no 
matter what other tracks are doing. 

Since the Record function always rounds recorded tracks to 
the nearest complete measure, the track always plays to the 
end of a measure before looping back, even if no notes are 
playing in the measure. 

Another important detail is that looping only works if you start 
playback before any of the tracks in the sequence have 
ended. If you have a short track and start playback in the 
middle of the song, after that track has ended, the short 
looped track won't play. 

To set a track to loop, simply click in the Loop box for the 
track, at the far right of the Track Sheet window. The Loop 
icon p will appear in the box. To turn the loop function off, 
click on the loop box again, and the icon disappears. 

"" Track Sheet 
Chnl PgM Loop Q 
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To playa sequence, first be sure to select the tracks you want 
to play, and check that the MIDI channels agree on your MIDI 
devices with the data in the sequence. If you wish, use the 
transport controls to move the Measure Counter to the point 
in the sequence where you want to begin playback. 

You can start playback in one of three ways: 

~ click on the Play button in the Transport window. 

~ press the spacebar on the Apple figs keyboard. 

~ assign a key on your MIDI keyboard to start playback. 
To select the key you wish to use for this purpose, use 
the Keyboard command on the Goodies menu. See 
Chapter 13 for details. 

Once you start the play function with one of these controls, 
the sequence will immediately begin to play if the Key and 
Count In settings on the Transport window are off, and if Sync 
is set to internal with the MIDI setup command on the 
Goodies menu. 

During playback, you can change tempo with the scroll bar on 
the Conductor window. 

You can even switch between windows while the sequence is 
playing, and examine data in any part of any track without 
Interrupting playback. 
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recording To record a track, first select it for recording by clicking in the 
a track Track Sheet window Record box as described earlier. 

record options 

multi-channel 
recording 

Start recording with one of these three options: 

~ Cl'lck on the Record button on the Transport window 

~ Press the Enter key (or Return) on the Apple figs 
keyboard. 

~ Play the key on your MIDI keyboard that you've 
assl~ned to the Record function. See Chapter 13 for 
details on how to make the key assignment with the 
Keyboard command. 

At this point, if the Key and Count In controls on the Transport 
window are off, and if Sync is set to Internal with the MIDI 
Setup command, Master Tracks Pro will immediately begin to 
record. 

Master Tracks Pro can record on all 16 MIDI channels 
simultaneously. After you've recorded a track containing data 
on multiple channels, you can use the Strip Data command 
on the Change menu to move the data for each channel onto 
its own track. If you wish, however, you can use the Record 
Filter on the Goodies menu to select a particular channel 
before you start recording (check Chapter 13 for details on 
the Record Filter). 

If you do select a channel on the Record Filter, Master Tracks 
Pro will only record the data from that channel, and will ignore 
any data it receives on other channels. In this case, you'll 
need to be sure that your synthesizer is set to send on the 
same channel before you start to record. 

Master Tracks Pro can record all types of MIDI data, but you 
can also use the Record Filter to filter out any types you don't 
want to record. Again, check Chapter 13 for more details. If 
you want to separate various types of data after the recording 
IS already complete, use the Strip Data command on the 
Change menu. 



Chapter 4 - Basic Sequencer Operation 4-11 

caution: 

stopping When you've finished recording, click on the Stop button in 
record the Transport window, hit the spacebar on the Apple figs 

keyboard, or play the key on your MIDI keyboard that you've 
assigned to the Stop function. 

As soon as you have finished recording a track, the 
program automatically activates the track for playback, and 
the play icon appears in the track's Play box. 

note: !Jl~;~fj99g'.!9~;3;'1(j'~e· ··9f9~g¢tiY:fl,tlngp:tt~c;~;~;).>.· 
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the The Conductor window is a small but very important Master 
conductor Tracks Pro window. On the Conductor window, you'll see the 

window current values for the tempo, the beat, and the meter, as set 
on a special Master Tracks Pro track called the Conductor 
track. 

changing 
the 

tempo 

Conductor 
T~mpo = 120 

I¢ limmiiii!iiiOii!!i!ii!iii!!l9I 

~ J=120 

If the Conductor window is not on the screen, or if it is hidden 
behind other windows, you can make it visible by choosing 
Conductor on the Windows menu. 

You can use the tempo scroll bar in the Conductor window to 
change the tempo, even while a sequence is playing or 
recording. There are three ways to do this: 

~ You can click and hold on the scroll box in the scroll bar, 
and drag it directly to a new value. 

~ Clicking anywhere in the grey part of the scroll bar 
moves the scroll box rapidly toward that location, and 

causes a corresponding rapid change in the tempo. 

~ You can click and hold over one of the arrow controls at 
either end of the scroll bar. This changes the tempo 
value one value at a time. 
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the 
conductor 

track 

The Conductor track is a separate track in a Master Tracks 
Pro sequence that determines timing for the entire sequence. 
The Conductor track allows each measure to have its own 
meter, tempo, and beat note, and the tempo can change 
gradually, even within a single measure. 

You can think of tempo changes you make in the Conductor 
window as offsets to the actual tempo value stored in the 
Conductor track. The play tempo in the Conductor window 
automatically follows the changes in the Conductor track 
tempo. When you change the play tempo using the 
Conductor window scroll bar, all the original tempo changes 
in the Conductor track are preserved, but they are scaled 
proportionally to the change you make. 

To enter new Conductor track settings for the entire 
sequence or a given range of measures, you may select the 
Change Conductor dialog box, either by clicking over the 
meter display in the Conductor window, or by choosing 
Conductor ... on the Change menu. See the section on 
changing Conductor values in Chapter 10 for details. 

Change conductor 
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Chan!;Jes to the Conductor track may also be made 
graphically using the Conductor edit window from the 
Windows Menu. See Chapter 7 for details. 
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song 
editor 

window 

Track Numbers 

The Song Editor allows you to edit large blocks of music at 
one time. Working on groups of measures, you can move 
sections of music within a sequence or build new sequences 
from segments of other sequences. You can also modify the 
data in a variety of ways USIng the commands in the Edit and 
Change menus. 

Select the Song Editor window by choosing it from the 
Windows menu, or by typing Command-2 on the Apple figs 
keyboard. 

Bar Numbers(measure ruler) End of conductor track 
Empty Measure 

Song Editor 
R.frain V.rs.2 

12 16 20 24 28 

BrJ:ly Measure 

Like the Track Sheet window, the song editor is a table of 
tracks in which each track is listed on a separate row. But 
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instead of alpha-numeric information, the Song Editor window 
provides a graphic representation of the musical data that the 
track contains, in one-measure blocks. 

full/empty The left border of the window is marked with the track 
measures numbers, and the top border is a measure ruler which marks 

off the measure numbers. Tracks containing MIDI data 
appear on the screen as a row of rectangular boxes, each box 
representing a measure. Solid black boxes contain MIDI data, 
while hollow boxes are measures of rests, without any MIDI 
data. 

end of The grey vertical bar at the end of the data area represents 
conductor track the end of the conductor track for the sequence. Even if the 

tracks you're looking at are completely empty of MIDI data, 
and no measure boxes are on the screen, the grey bar will still 
appear at the measure where the conductor track ends. 

scrolling You can scroll through the track data on the Song Editor 
through the window using the scroll bars as you would with other Apple 
song editor JIgs programs. You can also scroll using the method 

window described for selecting blocks of measures in the section on 
"Selecting measures to edit," below. 

playback point Clicking anywhere in the Song Window with Auto OFF, will set 
the transport to start playing or recording from that point. 

the The row of numbers at the top of the Song Editor window is 
measure the measure ruler. It marks off measures in the sequence so 

ruler that you can keep track of which part of the sequence you're 
looking at. You can change the numbering scheme displayed 
on the measure ruler by pressing one of the number keys 3-0 
across the top of the Apple //gs keyboard. If you press 3, 
every third measure on the ruler (1,3,6,9, and so on) is 
numbered, while the rest of the measures are indicated by 
hash marks. IfJOU press 4, every fourth measure is 
numbered, an so on. Pressing 0 numbers every tenth 
measure. The "+" key will increment your selection by one 
and the "-" key will change it back again. 
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using Master Tracks Pro provides markers that let you identify a 
song particular location in your sequence so that you can return to 

markers it any time you wish. Markers always mark the beginning of a 
measure. Master Tracks Pro markers look and act like tab 
stops in word processing programs. 

In Master Tracks Pro, markers are displayed at the top of the 
Song Editor window, just below the window's title bar, on 
another horizontal bar called the marker ruler. Markers are 
also displayed in the Step Editor and MIDI Data windows, but 
you can only place or move them using the Song Editor 
window. 

placing You'll see a small box at the left edge the marker ruler 
markers containing a hollow upside-down triangle. This box is called 

the well. To place a marker into the marker ruler, click and 
hold over the well. Another upside-down triangle, the marker 
you'll be placing, will appear just below the well. 

Now, while still holding down the mouse button, drag the new 
marker to the measure where you want to place it. Once 
you've positioned the marker, release the mouse button. The 
marker will remain where you've placed it, and will become 
solid black. In addition, a vertical dotted line will appear below 
the marker, extending through the track list to help you see 
exactly where the marked measure is in your track. 
You can move the marker any time you're in the Song 
Window, by clicking and holding on It, and dragging to its new 
location. 

moving to To move the Song Editor, Step Editor, or MIDI Data window 
a marker display to the next marker in the ruler, press the Tab key on 

the Apple figs keyboard. The data in the window will move so 
that the next marker is at the extreme left of the window. 
Press the Tab key repeatedly until you reach the marker you 
wish. Only the active window is affected. 

To move to a previous marker, press Shift-Tab. Again, the 
data lines up so that the marker is at the left edge of the 
window. 

In a large composition, you may want to make a note to 
yourself to help you remember the music each marker is 
pointing to. Master Tracks Pro helps out by letting you name 
the markers on the screen. Once you've named a marker, the 
name appears to its immediate right on the marker ruler. 
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naming a 
marker 

editing 
MIDI data 

selecting 
measures 

to edit 

You can name a marker or change its name from the Song 
Editor window. Double click on the marker to bring up a 
dialog box for the marker name. Type in the name from the 
Apple figs keyboard, then click on OK or press Return to 
enter it and return to the Song Editor. 

The Song Editor lets you easily change MIDI data in large 
regions using all the commands on both the Edit and Change 
menus. Again, the smallest unit available for editing changes 
in the Song Editor window is an entire measure, and all edits 
are done on multiples of whole measures. Also, the edits you 
make in the Song Editor window affect all types of MIDI data 
at once. Commands like Cut, Copy oan Paste from the Edit 
menu affect MIDI data such as controller data and program 
changes, as well as note information. 

To make changes to one or more measures of your 
sequence using menu commands, the region of measures 
must first be selected. Selected measures appear on the 
screen highlighted in inverse video. 

To select one or more adjacent measures in a single track (or 
tracks), click over the first measure in the track(s), and drag 
over the entire group. 

§O Song Editor 
[YI ... First Theme _Bass Theme .... H 

4 8 12 16 20 24 28 

~ :~t::::11I1I1 

: I 
selecting an To select an entire track, click on the track number in the left 
entire track hand column. To select several adjacent entire tracks, click 

and hold over the first track number in the group, and drag 
the mouse up or down in the track number field. 

;0 Song Editor 
[YI ,.. Verse 1 ,..Refrain .,.. Verse 2 
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selecting To select one measure in all tracks (including the conductor 
measures 1!:aQ!s), click on the column for that measure in the measure 
across all ruler at the top of the window. 

tracks CIk:kHere 

~D 

lead in 

4 8 t ____ m ___ _ 

2 t::Jd .................. ... 
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To select adjacent measures in all tracks, click and hold on 
the column for the first measure in the group and drag to the 
column for the last measure. 

de-selecting To deselect a selected area, simply click anywhere on the 
areas Song Editor window. 

selecting a 
block of 

measures 

To select a block of measures across multiple tracks,position 
the mouse pointer at one corner of the block,click, and drag 
towards the diagonally opposite corner until the inverse 
highlight covers the measures you want to select. 

shift click Second, a block can be defined by clicking at one corner of 
the block, holding down the shift key on the Apple figs , and 
then clicking on the diagonally opposite corner. 

To define a block that is larger than one screen, you can scroll 
with the scroll bars after clicking on the first corner, but you 
must hold down the shift key before you click on the data area 
again. 
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note: 

editing Once you have selected a measure or measures, you can 
the selected edit the region using the commands on the Edit or Change 

music menus. See Chapters 9 and 10 for instructions. 

playing 
a sequence 

from the 
song editor 

scrolling during 
playback 

selecting a 
playback point 

moving 
to the 

step editor 

Master Tracks Pro lets you play your sequence no matter 
what window you're using, and the Song Editor window is no 
exception. Just click on the Transport's Play button or hit the 
spacebar to start playback. . 

If you wish, you can set the Song Editor screen to scroll 
through the sequence data during playback, using the Follow 
Playback command on the Layout menu. If the Follow 
Playback command is on, and the Song Window is selected 
as the active window, a vertical highlight bar moves along the 
track data to mark the measure that is currently playing. 

You can also use the Song Editor to determine at what point 
the song begins playing. This capability is useful when you 
want to hear just the part of the song you're working with, and 
you can also use it as an alternative to the fast forward and 
rewind buttons on the transport window. 

To determine the point at which play begins,first turn the 
Transport window's Auto control Qff. With Auto off, and the 
Song Editor Window active, click in the window at the place 
you want playback to begin. It's that simple. Once play begins, 
scrolling the Song Editor window has no effect on what you 
hear. 



The Step Edit window is used exclusively for note data. It 
provides a variety of precision tools that let you input and edit 
notes in small groups or individually. 

10 
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Select the Step Editor window by choosing it from the 
Windows menu, or by typing Command-3 on the Apple /lgs 
keyboard. You can also open the Step Edit window at a 
specific measure in a particular track by double clicking on 
that measure in the Song Editor window. 

The Step Editor window is devoted primarily to a graphic 
display of one track's worth of note events. 

The note data itself is displayed in the data area as a 
sideways player piano roll. Each note is represented as a 
small rectangle, or note bar, oriented horizontally in the data 
area. 
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Along the top border of the data area is a measure ruler, 
which marks off the measures and beats in the track. At the 
left border there's a keyboard graphic to indicate the pitches 
of the notes in the track. 

Just above the top border of the data area is another 
horizontal bar, the marker ruler. If any markers are set, they'll 
be displayed here just as in the Song Editor window. 

At the top of the window there are two rows of icons and 
parameter settings, collectively called the menu bar. On the 
top row of the menu bar, you'll see several note icons, 
representing the rhythmic values of the notes you insert; a 
tuplet box; and controls for note articulation and velocity. 

On the second menu bar row are several note editing icons, 
pitch and time indicators, and track and MIDI channel 
controls. 

All of the options on the first menu bar row, along with the 
channel control, are used only during input of new notes. The 
remaining options are used in a variety of editing functions. 

scrolling As in the Song Editor window, you can scroll through the data 
the window in the Step Editor window with scroll bars. 

moving Just as in the Song Editor window, markers are displayed on a 
to a marker ruler near the top of the Step Editor window, and you 

marker can move the display to a marker position using the Tab and 
Shift-Tab keys. However, you can only set the markers in the 
Song Editor. 

zooming Master Tracks Pro's two Zoom commands let you decide how 
in and much of the track data you can see at one time on the Step 

out Editor window. Like a zoom lens, the Zoom commands let 
you Zoom in or out for different levels of "magnification." You 
can zoom in to work on small portions of the track more 
precisely, or zoom out or to see more notes all at once. 
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To zoom in, choose the Zoom In command from the View 
menu or press Command-[ on the Apple Ilgs keyboard. To 
Zoom out, choose the Zoom Out command, or press 
Command-] on the keyboard. 
50 Step Editor 
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switching The Step Editor window displays note data from only a single 
to another track at a time, and you must switch the display to another 

track track to edit its data. Change tracks by clicking on the Track 
box. When the change value window pops up, type in the new 
track number, or click on the arrow controls to change it 
incrementally. 

Click on OK once you've entered the correct number, or press 
Return on the Apple Ilgs keyboard. The change value window 
will disappear, and the new track will be displayed. 

playing a As in the Song Editor window, you can play your sequence 
sequence while you are using the Step Editor window. 

scrolling during At your option, you can have the Step Editor window scroll 
playback through the track data while the sequence plays. Choose the 

Follow Playback command on the Layout menu to enable this 
feature. As each measure plays, its indicator at the top border 
of the data area gets highlighted in inverse video. The Step 
Editor Window must be selected as the Active Window for 
scrolling to take place during playback. With Follow Playback 
turned off, the Step Window can be scrolled and examined 
independently of transport counter position during playback. 
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playback 
point 

editing 
note 
data 

editing 
regions 

of notes 

The playback I record start point can be set by clicking with 
the arrow cursor in the Step Editor Window at the desired 
location, providing Auto is off, just as in the Song Editor or 
MIDI Data Windows. 

Master Tracks Pro gives you powerful control over the step 
editing process with a variety of editing options. You can 
select editing regions, just as in the song editor window, and 
you can also add, delete, edit, move or copy individual notes. 

With regional editing, you can quickly edit a group of notes all 
at once. Using the commands on the Edit and Change 
menus, you can move, copy, or delete the note data, 
transpose the pitches of all the notes in the region; change 
MIDI data such as MIDI duration and note velocity; and alter 
timing in several ways. See the chapters on the Edit and 
Change menus for more details on these features. 

--::..-__ --:........ !ll!11 
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To edit a region of notes, the region must first be selected 
using the arrow cursor. On the Step Editor window, a region 
consists of all notes in the track along a horizontal section of 
the window, in other words, between two points in time in the 
sequence. You cannot define regions vertically (by pitch)-all 
pitches are automatically included in a selected horizontal 
region. 

pitch and For many operations, you'll need a way to locate notes 
time indicators precisely in the data area both in terms of time and pitch. That 

guidance is provided by the time and pitch indicators in the 
menu bar. This information is also included in the note itself -
simply double click on the note and a data window will pop up. 
See the section on "editing note parameters numerically" later 
in this chapter. 
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The time indicator always displays the time value at the 
current position of the cursor, in measures, beats and clock 
ticks. 

Trre 

The pitch at the current cursor position appears in the pitch 
indicator, displayed as a pitch letter name and an octave 
number. Master Tracks Pro can handle all MIDI pitches, a 
range from C -2 to G8 (middle C is C3). Accidentals are 
always displayed as sharps. 

choosing Since all editing operations occur on clock tick boundaries, 
zoom level how precisely you can define the beginning and end of a 

region depends on the Zoom level. At the highest 
ma~nification, zoomed all the way in, you can define the 
region by individual clock ticks (there are 48 clock ticks per 
quarter note). When you're zoomed all the way out, on the 
other hand, the resolution is much coarser and the smallest 
movement of the mouse represents 4 clock ticks, or one 
twelfth of a quarter note. 

Important: 

No matter which Zoom level you're using, you'll need a way to 
keep track of where you are in the sequence while you're 
defining regions. For many editing commands, the measure 
and beat demarcations in the measure ruler at the top of the 
step editor window will give you all the information you need 
to locate the end points of your region. For more precise work 
however, you can use the time indicator in the menu bar to 
begin and end the region at exactly the right point. 

Notice th1:\t as you move the arrow pointer around on the data 
area, the time indicator changes to show the exact beat 
location of the current pointer position. 



6-6 Master Tracks Pro 

tied notes There is an exception to the rules just mentioned, however. 
Notes in the selected region that are tied over from an earlier 
measure are recognized by commands such as Cut, Copy, 
and Clear if the region begins precisely on the measure 
boundary. See the section on tied notes in Chapter 9 for more 
detail. 

selecting a To select a region for editing, choose the arrow pointer on the 
region for step editor menu bar by clicking on it. Now, move the pointer 

editing into the data area to the left edge of the region you wish to 
select. 

Click and hold the mouse button, drag the pointer to the right 
edge of the region. You can scroll the screen while selecting a 
region by dragging the pointer to the right screen boundary. 
As you select a region, the region becomes highlighted in 
inverse video. 

Release the mouse button when you've defined the region as 
you want it. You can now use the Edit and Change menu 
commands on the selected region. Clicking in the measure 
ruler will select an entire measure at a time. You can select an 
area and then use the scroll bar to scroll to the end of the area 
you wish to select and hold the Shift key while you click the 
mouse. This selects the entire area. 

inserting Master Tracks Pro gives you two ways to insert new notes in 
new your sequence: you can use the mouse exclusively, or you 

notes can enter the desired pitch by playing the corresponding key 
on your MIDI keyboard. 
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choosing With either method, you start the process by selecting values 
note for the note's duration, velocity, MIDI channel, and length. 

durations Choose the duration, or rhythmic value, you want by clicking 
over the appropriate note icon at the left side of the menu bar. 
Selecting the dot icon multiplies the duration of the note value 
by 1-1/2. 

tuplets 

If you wish, you can select a combination of note values, and 
all the selected values add together for the total duration of 
the note you are inserting. To select more than one value, 
click on the first note type you want to select, and then hold 
the shift key down as you click on the remaining note types. 

To enter notes with tuplet values, click over the word "Tuplet" 
in the tuplet box in the menu bar. When the box is highlighted, 
any notes you insert will have the tuplet value shown in the 
box. .. .. ,....., ...... , 

Step Editor 

Track - 1 

For example, say the value in the tuplet box is 3:2, and you've 
selected the eighth note duration icon. In this case, with the 
tuplet command on, the timing of the notes you insert will be 
adjusted so that three of these notes would fit in the time 
normally occupied by two regular eighth notes. This is 
equivalent to eighth note triplets. For a quintuplet you would 
select 5:2. 

You can choose a wide range of tuplet values to create 
complex polyrhythms or to experiment with other unorthodox 
note timings. To set a new tuplet value, click over the upper 
or lower value in the tuplet box. A small Change Value window 
will pop up, allowing you to change the tuplet value. Then click 
over the arrow controls to raise or lower the number as you 
wish, or type in a number from the Apple Ilgs keyboard. 

When both numbers are correct, click on OK or press Return 
to enter them and return to the Step Editor window. 
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setting 
other 
note 

values 

Notes you insert in the track in the Step Editor window take on 
the values displayed in the menu bar for length, on and off 
velocity, and input MIDI channel. Length refers to the 
percentage of the note's duration value that it actually plays. 
By varying the length setting, you can add changes in note 
length to define phrases or legato and staccato passages. 
Shorter lengths produce a more staccato effect. The input 
channel and velocity settings refer to the standard MIDI input 
parameters. 

Before inserting a note, you can change the current settings 
for these parameters by clicking on the appropriate fields. 
When you do, the corresponding Change Value window will 
appear. You can either type in a new value from the Apple 
I/gs keyboard, or click over the arrow controls to raise or 
lower the value incrementally. Then click on OK or press 
Return. 

inserting notes To insert notes using the mouse, first select the pencil icon in 
with the the menu bar by clicking on it. When you move the pointer to 
mouse the data area, it becomes a crosshair that lets you position 

the new note exactly where you want it on the screen. 

inserting 
notes 

with a MIDI 
keyboard 

Using the keyboard graphic at the left of the data area and the 
measure and beat markings along the top, align the crosshair 
so that it corresponds to the pitch and time where you want to 
insert the note. You can also use the pitch and time indicators 
in the menu bar to locate the position precisely. 

When you have the correct position, single click on the 
mouse. A new note bar will be inserted into the data area at 
that position, its length corresponding to the duration and 
length you selected. 

Follow the above steps for selecting the note's duration, 
input channel, and length. Then, select the keyboard icon 
next to the arrow in the menu bar by clicking on it. Since 
you're using your MIDI keyboard to enter pitch and velocity 
data, you don't need a crosshair, and the mouse pointer 
remains an I-beam cursor when you move it into the data 
area. 

Position the I-beam at the horizontal position where you want 
to enter the first note. Use the time indicator in the menu bar 



rests 

backspacing to 
erase mistakes 
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for precision. Once you've positioned the cursor properly, 
click on the mouse to activate the insertion point for MIDI 
keyboard note entry. 

Now you can enter notes by pressing the corresponding keys 
on your MIDI keyboard. Each time you playa key, a new note 
bar will appear at the pitch and time you specified, and the 
I-beam cursor advances to the next insertion point. If you play 
a chord, (hold down notes while adding additional ones), all 
it's notes will start at the same time. As you continue to insert 
notes, the Step Editor window scrolls appropriately. Velocity is 
recorded with each note and can be adjusted if you like from 
the Change menu. 

Pressing the right arrow on the Apple figs keyboard inserts a 
rest corresponding to the note duration that is currently 
selected. 

If you play the wrong key during the pitch entry process, press 
the left arrow key on the Apple figs keyboard to delete it. In 
fact, you can "backspace" all the way back to your last 
insertion point if you wish. 

During the note entry process, you can switch to new note 
durations with either the note icons on the menu bar, or via 
the MIDI keyboard using keys you've assigned to duration 
values with the Keyboard command on the Goodies menu 
(see Chapter 13 for details). 

moving and With the move and c0p.y commands, you can transfer all of a 
copying note's data, including Its duration, channel and velocity to a 

notes new location. Of course, the pitch and/or the start time of the 
note at the new location may be different, depending on 
where you move the note. 

moving To move a note somewhere else in the track, or to make a 
the note copy of a note at another location, you'll need the crosshair 

mouse pointer. To get it, click over the pencil icon in the menu 
bar, and then move the pointer over the note you want to 
move or copy. The center of the crosshair must be directly on 
the note. Although the center of the crosshair can be 
anywhere along the note's length, it's best to place it precisely 
at the beginning of the note, so that you can use the time 
indicator In the menu bar to locate the point where you insert 
the note with precision. 
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Now, if you want to move the note from its current position to 
a new one, simply click and hold the mouse button. A dotted 
border will appear around the note bar, and while you 
continue to hold the mouse button you can drag this "note 
ghost" to a new pitch and/or time in the sequence. When the 
note is correctly positioned, release the mouse button. The 
ghost will be returned to life as a solid note bar at the new 
location, while the note bar at th/? previous location will vanish. 

shift click There will be times you want to shift a note's position in time 
but not change its pitch, or vice versa. To make these 
operations easier, Master Tracks Pro provides a way to lock 
in a note's pitch or start time during a move operation. 

copying 
the note 

erasing 
onate 

To lock in the pitch or start time, hold down the shift key and 
then click and hold on the note. Now, as you continue to hold 
down the mouse button, whichever way you first move the 
mouse locks in the note's position on the other axis. 

So, for example, if you first move the mouse horizontally, 
you've locked in the pitch, and you can't move the note 
vertically. You can now only move the note horizontally, in 
time. Except for this detail, the move operation proceeds 
normally. 

Copying a note involves essentially the same steps, except 
that instead of just clicking over the note you want to copy, 
you must hold down the Option key on the Apple figs 
keyboard before you click on the note. Once the "note ghost" 
border appears, you can release the Option key, and 
continue by dragging the cursor to the location where you 
want to insert the copy. When you're in position, release the 
mouse button, and a new note bar will appear. The original 
you copied from remains where it was. 

You can erase an individual note with the eraser mouse 
pointer. Click over the eraser icon in the menu bar. When you 
move the pointer down into the data area, it becomes a 
crosshair inside a circle. 

To erase a note, simply position this eraser cursor anywhere 
along the note and single click. The note will disappear from 
the window. 
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Editing commands for single note events allow you to place 
new notes in your sequence, and to move, copy, or delete 
existing notes using the mouse. If you need more precision, 
Master Tracks Pro also gives you a numeric method for 
altering each note's data. 

To alter an individual note's pitch, start time, duration, on and 
off velocities, or channel, select the arrow mouse pointer by 
clicking over the arrow in the menu bar. Move the arrow 
directly over the note you want to edit, and double click. 

grey highlighted note 

After a moment, the Edit Note window pops up, and a gray 
highlight appears over the note being edited so you won't 
forget which one you're working on. 

To change one of the values in the window, select it by 
clicking on it to highlight it. Use the arrow controls at the right 
of the window to change the value incrementally, or type in a 
new value directly from the Apple I/gs keyboard. Master 
Tracks Pro won't let you enter mvalia settings for these 
parameters, and will only beep if you try. 

The Start Time parameter refers to the point in the sequence 
that the note be~ins, in measures, beats, and clock ticks. 
Rather than setting an end time, however, you use the 
Duration parameter to determine how long the note lasts, 
again in measures, beats, and clock ticks. 

You can change the MIDI key number (Pitch) with the arrow 
controls, or by typing a pitch letter name followed by an 
octave number, or by pressing the appropriate key on your 
MIDI keyboard. 

change The On Velocity and Off (release) Velocity are changed with 
velocIty the arrow controls, or by clicking on the value and typing a 

new number. 
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change In order to change the output MIDI channel on a note or 
channel range of notes, the channel setting in the Track Sheet 

Window must be set to "0". It can then be changed with the 
arrow controls, or by typing a new value. 

tip 

setting the 
changes 

Once all the parameters in the Edit Note window are to your 
liking, click on OK or press Return to finalize them and close 
the window. You can click on Cancel instead to return to the 
Step Editor window without making any changes. 

special You can control the Track Sheet status of the current track 
keyboard from the Step Editor window using special keyboard 

commands commands. 

Option - P - toggles play / mute 
Option - R - toggles record on / off 
Option - S - toggles solo on / off 
Option - L - toggles loop on / off 

Using these Option key combinations saves the bother of 
making the Track Sheet window active in order to effect 
playback changes to the track you're working on. 



opening 
a data 

window 

Master Tracks Pro provides six special MIDI Data windows for 
graphically editing types of MIDI data other than notes on an 
event-by-event basIs. Instead of having to work with a long list 
of numbers, you can see your data at a glance on the graph, 
yet you can still edit it with full precision. You'll find separate 
MIDI Data windows for pitch bend, channel pressure, key 
pressure, modulation, controllers, and program change data. 

Here's an example of a MIDI data window showing aftertouch 
(Channel Pressure). 

There are two ways to open a MIDI Data window. First, you 
can choose it from the Windows menu with the mouse. 
Second, you can open it from the Apple figs keyboard by 
typing the Command key along with the number key that 
corresponds to the window, as follows: 
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~ Pitch Bend 

Track Sheet 01 
Song Editor 02 
step Editor 03 

Pitch Bend 04 
Channel Pressure 05 
Key Pressure 06 
Modulation 07 
Controllers OB 
Program Change 09 
Conductor Edit 00 

../Cond 

~ Channel Pressure 
~ Key Pressure 
~ Modulation 

Command-4 
Command-5 
Command-6 
Command-7 
Command-8 
Command-9 
Command-O 

~ Controllers 
~ Program Change 
~ Conductor Edit 

If the window is open but hidden behind other windows on the 
screen, you can bring it up to the foreground by choosing it on 
the Windows menu or with its Apple figs keyboard command. 

All seven of the MIDI Data windows look and work alike, and 
are very similar to the Step Editor window as well. Most of 
each window is devoted to a data area, where individual MIDI 
events appear as vertical lines or points. The height of each 
line or point corresponds to the numeric value of the event, 
while the horizontal location of the line or point specifies when 
in the track the event occurs. You can see event data for one 
track at a time in the data area. 

You can toggle the display from lines to points by presing any 
key on the Apple //gs keyboard when the MIDI data window is 
active. 

At the top of each window, just below the window title bar, 
you'll see a single row of icons and data, the menu bar. The 
three icons in the left portion of the menu bar are used to 
select different editing operations (see the section below on 
editing event data). 
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To the right of the icons, there's a time indicator that displays 
the horizontal position of the cursor in the track, in measures, 
beats, and clock ticks. Next there's a value indicator, that 
gives the data value corresponding to the cursor's vertical 
location in the data area. Finally come boxes showing which 
track's data is currently on display, and what channel will be 
assigned for new event insertions. 

Just below the menu bar is a row of mostly empty space, the 
marker ruler. This is where the markers you've placed in the 
Song Editor window, if any, will be visible. 

Below the marker bar is another horizontal bar, the measure 
ruler, which marks the position of measures and beats in the 
track. 

Use the scroll bar controls to move the MIDI Data window 
displays just as you would with the Song Editor or Step Editor, 
or with scrollable windows in other Apple figs programs. Use 
the measure ruler to keep track of where you are in the 
sequence as you scroll. 

You can also move to markers that you placed in the 
sequence on the Song Editor window. Press Tab to move 
each successive marker. Press Shift-Tab to move to a 
previous marker. Playback position can be determined by 
clicking at the desired location in any Midi Data Window, with 
Auto turned off in the Transport, the same way as in the Song 
and Step Editor Windows. 

You can use the Zoom In and Zoom Out commands on the 
Layout menu to see more of the MIDI data on screen at a 
time, or to get a close up view of a small amount of data for 
precise work. 

Note that the more you zoom in, the more individual events 
you can place in the sequence. Zooming in gives you more 
precise control over the placement of each event, but you can 
easily use up large amounts of memory, and the sequence is 
forced to send data much more rapidly. Use the Zoom level 
that matches your needs for precision, memory, and data 
density. 

Consult Chapter 12 for more details on how to use Zoom 
commands. 
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switching To view or edit MIDI event data on another track, click over 
tracks the Track box in the menu bar. A Change Value window pops 

up, and you can either type in the desired track number from 
the Apple figs keyboard, or change it by clicking on the arrow 
controls in the window. When you've entered the correct track 
number, click on OK. The Change Value window will 
disappear, and the Event Editor window will now display data 
for the new track. 

Editing As in the Step Editor window, you use various mouse pointers 
MIDI to make different kinds of changes on events in the various 

Data MIDI Data windows. 

selecting 
a region 

To use the commands in the Edit or Change menus on MIDI 
Data window data, you must first select a region within the 
track. To select a region for global changes, use the arrow 
pointer by clicking on its icon in the menu bar. Move the 
pointer to the left edge of the region you want to select, using 
the time indicator in the menu bar to help you locate the 
desired point in the sequence precisely. Then click on the 
mouse, and drag across the selected region to the right. As 
you move the mouse, the region will be highlighted in inverse 
video. 

When you reach the right edge of the region, release the 
mouse button. You can now perform Edit and Change menu 
operations on the selected region. For the most part, these 
changes will only apply to the type of data displayed in the 
window (see the discussion in Chapter 9 on how different 
types of data are affected by the Edit menu commands in the 
MIDI Data windows.) 

inserting The ability to enter MIDI events graphically is one of Master 
events Tracks Pro's most powerful features. To insert individual MIDI 

events or modify existing ones, you select the crosshair 
pointer by clicking on the pencil icon in the menu bar. 

Before inserting a new MIDI event, however, you can use the 
Channel box in the menu bar at the top of the window to select 
the MIDI channel for the new event. Click on the Channel box 
to bring up a Change Value window, and enter the desired 
channel number by typing it in or adjusting it with the arrow 
controls. Click on OK or press Return to finalize the change. 



inserting 
consecutive 

events 
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To insert a single event, move the crosshair to the position in 
the data area where you want the event to go. Use the time 
indicator in the menu bar to locate the exact time in the track 
where you want to insert the event along the horizontal axis of 
the graph. Use the value indicator to position the cursor 
vertically for the correct value. 

Now simply click the mouse. A vertical line will appear, 
extending from the graph baseline to the height representing 
the data value. 

You can insert multiple consecutive events simply by holding 
down the mouse button and dragging the cursor to draw a 
curve on the data area. This makes it easy to add smooth 
pitch bend or mod wheel changes. 

When you insert consecutive events, the graph will appear to 
be filled in with solid black under the curve you draw. Each 
event along the curve can still be edited individually. 

event The Zoom level you're currently using affects how many 
resolution events are inserted when you draw in a curve by dragging the 

mouse across the data area. Depending on the Zoom level, 
each horizontal mouse position can represent as many as 4 
clock ticks or as few as 1. 

If you're zoomed all the way out when you draw consecutive 
events, you'll get a new event every 4 clock ticks. When you're 
zoomed all the way in, you get a new event with every clock 
tick. Be cautious about entering consecutive events when you 
are zoomed in, because you can use up memory quickly and 
you may force the program to send data too rapidly. The Midi 
Data stream can only support 3120 bytes per second. 

A good way to enter a series of consecutive events is to draw 
them in when you are zoomed out to save memory, and then 
zoom in to edit them precisely. When you zoom in, you'll see 
the solid black graph resolve into individual event lines, 
making it easy to position the cursor. 

changing To change events that are already stored in the track data, 
existing just insert a new event at the same time. When you do, the old 

MIDI event will be erased. 
events 
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thinning out If you have a section of MIDI data that is denser than 
dense MIDI necessary,you can thin the MIDI data by tracing over their 

data curves with the mouse at lower resolutions ( Zoomed out). 

erasing 
events 

the 
pitch bend 

window 

switching 
between 

line and dot 
display 

To erase individual events, click on the eraser icon in the 
menu bar to select the eraser cursor, a crosshair within a 
circle. Move the cursor directly over the event you wish to 
erase and click. The event line will disappear. You can wipe 
the eraser across a series of events to erase them all. 

Pitch bend data can take either positive or negative values. 
When a note is not being bent it has a pitch bend value of O. 
So in the Pitch Bend window (ou'li see a horizontal dotted line 
running through the middle 0 the data area marking the zero 
point. The area above the line, which represents positive pitch 
bend values, is marked with a "+" in the left border. The area 
for negative values below the line is marked with a "_". 
Positive values range to + 127 and negative values go down to 
-128. 
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You can switch between two options for displaying pitch bend 
and other MIDI data. Normally, the data appears as vertical 
lines. However, if you press any key on the Apple I/gs 
keyboard while you're working with any MIDI Data window, 
each event is displayed as a single dot in the graph. Pressing 
another key will toggle back to the normal display. 
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Channel Pressure, also known as Aftertouch affects all notes 
on a given MIDI channel. It has a range of 0 to 127. 

Key Pressure, also known as "polyphonic" aftertouch, affects 
individual MIDI notes. To use this parameter, you must first 
specify the note you want to assign the key pressure event to 
by entering its pitch in the appropriate box at the far right of 
the menu bar. A box will pop up, and you can either type in the 
note's pitch or play the note on your MIDI controller. 

The value range for Key Pressure is 0 to 127. 

modulation Modulation refers to the "Mod" wheel(or lever) found next to 
window the Pitch Bend wheel on many synthesizers. It is MIDI 

Controller #1 and you could also edit or create Modulation 
Data in the Controllers Window. Like many other controllers, it 
has a range of 0 to 127. 

controllers Since MIDI allows multiple controllers, the Controllers window 
window lets you specify the controller number for each event in the 

window. You must select the controller number before you 
insert the event (consult the owner's manual of your MIDI 
device for valid controller numbers and their associated 
range of values). 

program 
change 
window 

Click in the appropriate box at the right of the menu bar. Enter 
the controller number in the box that pops up, and click on OK 
or press Return to enter it. Then insert events just as you 
normally would. You can switch to a new controller number at 
any time. Refer to the Controllers List in Chapter 14. 

The Program Change Window lets you view, enter and edit 
program changes. Sending a program change on a given 
MIDI channel will affect all MIDI devices listening to that MIDI 
channel. Clicking in the data window will pop up the program 
change dialog (from the Track Sheet). Simply select the 
number or press the preset on your synth to enter a value. 
The range of Program numbers is 1 to 128. 
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conductor track The Conductor Track Data Window shows a graphic 
data window representation of the Conductor Track. Like other MIDI data 

windows, the tempo values can be edited with the pencil and 
eraser cursors, but unlike the other data windows, selecting 
an area with the arrow allows only Change operations to that 
area in the Conductor dialog box. The other Edit Menu 
commands are inactive. Tempo changes may be entered on 
any clock boundary (48 clocks per quarter note). A tempo 
indicator appears at every measure boundary. These cannot 
be erased but can be changed with the pencil. 

Ij;; 

~I 

This window is intended as a graphic representation for 
viewing and allows for very precise editing of the conductor 
track. Broader editing such as smooth changes over a 
selected region should be performed in the conductor dialo~ 
box from the Change menu. The results will then be visible In 
the Conductor Track Data Window. 
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The File menu has a variety of commands that let you 
manage your sequence files. These commands work just as 
they do in most other Apple figs applications, so if you've had 
any previous experience with the Apple figs you'll already be 
familiar with how to use them. 

The File menu includes the ability to use MIDI Files. MIDI 
Files are an industry standard format for storing MIDI 
sequences. If you own any programs that support this new 
format, you will be able to share sequence files with these 
programs. You can save your sequence as a MIDI File 
(Export), or Import a MIDI File created with another program. 
A Master Tracks Pro file is a single sequence, either in its 
temporary form in your Apple figs's memory, or stored more 
p'ermanently on a disk. A file is open when you're working with 
It in your Apple figs's active memory, whether you loaded it 
from disk or started a new sequence from scratch. When you 
close a file, it is removed from memory, and you can only 
work on it again by reloading it from the disk. 
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You can only have one sequence file open at a time in 
Master Tracks Pro. If you're already working on a file, Master 
Tracks Pro gives you a chance to save it when you create a 
new file or when you load a file from disk. 

Be sure to save your sequence files frequently while 
you work with them, so that you don't lose your work 
because of a power failure or other problems with your 
system. You can store files on any disk or drive in your 
system, as long as there is enough space, using options in 
the Save and Save As ... commands. 

To create a brand new sequence, choose the New command 
on the File menu or press Command-N on the Apple figs 
keyboard. Since you can only have one file open at a time, 
this command closes the file you've been working on, if any, 
giving you a chance to save it first if you like. 

When the new file is opened, any windows you had open 
remain on screen in the same position, but all the existing 
data disappears. Master Tracks Pro calls the new file 
"Untitled" until you rename it with a name of your own choice 
using the "Save As" command (the file name is always 
displayed in the Transport window title bar). 

Choose the Open command or press Command-O on the 
Apple figs keyboard when you want to load an existin~ disk 
file into Master Tracks Pro for playback or further editing. 
When you choose the Open command, Master Tracks Pro 
will first give you a chance to save the file you're currently 
working on, if any. 

Next, a dialog box will pop up, showing the name of the disk 
in the currently selected drive at the upper right, and the 
names of all the Master Tracks Pro files stored on that disk in 
a scrollable box at the left. If the list of files is too long to fit into 
this box, you can use the scroll bar at the right side to scroll 
through the list to the file you want. 

If the file you want is on a disk in another drive, click on Disk 
to select another drive. If you want a file on a disk that's not 
currently in a drive, Eject, insert the disk you want, then click 
on Disk to see the contents of the current disk. 
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Once you've located the file you want to open, click over any 
portion of the name. The name will now be highlighted, 
mdicating that it is selected. If you make a mistake, you can 
select a new file name just by clicking on it. When you've 
selected the correct file, click on Open. The dialog box will 
disappear, and Master Tracks Pro will load the file. 

Another way to open the file is simply to double click on its 
name when it shows up in the dialog box while you are 
running Master Tracks Pro. 

After the file is opened, the same set of windows you were 
using before you opened the file will still be on the screen, but 
the data in the windows will now be from the newly opened 
file. 

Use the Close command to end work on a particular file 
without leaving Master Tracks Pro. When you choose the 
Close command, you'll be given an opportunity to save your 
current work if you've made any changes since it was last 
saved. 

All windows you've been using remain on the screen, but they 
are now empty of data. Essentially, the Close command gives 
you another way of starting a new sequence. 

saving a The Save command stores the sequence that's currently 
sequence open on disk, if an earlier version of the file has already been 

file saved. As soon as you choose the Save command or press 
Command-S on the Apple figs keyboard, Master Tracks Pro 
will save the current version of the sequence in the same disk 
file, without any further action on your part, overwriting the 
existing file of the same name. 

If your file has not been saved before, or if y.0u haven't made 
any changes since the last time you saved It, the Save 
command is disabled and appears in grey instead of black on 
the File menu. To save a file for the first time, or to resave a 
file that has already been saved, use the Save as ... command 
instead. 



8-4 Master Tracks Pro 

using the 
Save as ... 

command 

~ IG. prol.O 
Free I OO~ out of 800~ 

lei! Sequences I 
t.~ 1'0), rnoni( II .... 

D l)O h(JHJ(! "\ 
D IJ(Hll'W)'(WI: (!)' 

D Hil)ll(W l.OUI) 

D Hil)ll(l)' l.OUI) I: I:S 
t.) ll)'tll)'k midi 1 

Soue os what file: 

Disk 

[New Folder] 

Open 

Close 

IT Saue D 
Cancel) 

The Save As ... command lets you save a new file for the first 
time, or resave a file that has previously been saved, using a 
new name if you wish. You may also save your file on a 
different disk. In addition to its importance for saving new files, 
this command is especially useful when you want to store 
your latest edits as a different file to avoid erasing an earlier 
version of the sequence. 

When you choose the Save As ... command, a dialog box 
appears, which allows you to choose a name for the file 
before you save it. The field where you enter the file name is 
labeled "as what File:." If you're saving a new file, the program 
will supply the name "Untitled" in the file name field. If you're 
saving a previously saved file, the current name of the file 
appears in the file name field. 

If you want to change the name supplied by the program, type 
in the new name. If you leave the file name field highlighted, 
the name in the field will disappear as soon as you start to 
type in the new name. 

The Save As ... dialog box also lets you select the drive and 
disk where you want to store the new version of the file. At the 
top of the box, you'll see the name of the disk in the currently 
selected drive. Eject this disk. When the disk pops out, insert 
the disk you want to use. Click on Disk to use your new disk for 
the save operation. 

If you decide you don't want to save the file after all, you can 
click on Cancel at any time. To go ahead and save the file with 
its new name, click on Save. After a few moments, you'll be 
returned to the main Master Tracks Pro screen. 



Chapter 8 - Using the File Menu 8-5 

using the Choosing the Revert to Saved command loads the disk 
Revert to Saved version of the file that you're currently working on, restoring 

command the file to the way it was when you last saved it. Use this 
command when you've made changes in a sequence that 
you know you don't want to keep. 

importing and 
exporting 
MIDI files 

When you choose the Revert to Saved command, Master 
Tracks Pro pops up a dialog box asking you if you're sure that 
you want to discard the changes you've made since the last 
time you saved the file. If you want to go ahead with the 
command, click on Yes, and the last saved version of the file 
will be loaded, replacing the data that was in memory. To 
cancel the command, click on Cancel. 

MIDI Files are an industry standard format that has been 
adopted by many software and hardware manufacturers. 
This allows you to use Master Tracks Pro to play or edit files 
created on other sequencers or to use your Master Tracks 
Pro files with other sequencers or notation programs. Both 
types of MIDI Files are about 35% smaller than a normal 
Master Tracks Pro file and thus take less room on your disk 
and less time to transmit by modem. 

When you select EXPORT from the File menu, a dialog box 
gives you the choice of type 1 or type O. When you select 
IMPORT from the File menu, Master Tracks Pro will display 
any MIDI files on current disks. 

Type 0 

Type 1 

All channels merged to a single multi­
channel track. 
Channel assignments saved 
Text and program change assignments 
.IlQ1 saved. 
Loop assignments and markers not 
saved. 

Parallel multi- channel tracks. 
Channel assignments saved. 
Text and program change assignments 
saved. 
Loop assignments and markers not 
saved. 
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Choose the Quit command or press Command - Q on the 
Apple //gs keyboard when you want to end a Master Tracks 
Pro session. If you haven't saved the file you've been working 
on when you choose the Quit command, Master Tracks Pro 
gives you a chance to do so via a dialog box with the message 
"Save changes before quitting?" 

Click on Yes or press Return to save the final version of the 
file before quitting. Click on No if you want to quit without 
saving the file. If you decide not to quit after all, click on 
Cancel. 



Master Tracks Pro's Edit menu contains commands that are 
used within the Song Editor, Step Editor, or MIDI Data 
windows to edit MIDI data in selected measures or regions. 

Cut 
Copy 
l>osl(~ 

Clear 

Mill Outu :":1'>1 
Insert Measure... 3e1 

Select nil 3en 
Show Clipboard 

To use any of these commands on a specific region, the 
region must first be selected using the mouse as described in 
the chapters on the Song Editor, Step Editor, and MIDI data 
windows. If you want to use an Edit command on an entire 
sequence or track, you can skip that step by using the File 
menu's special command, Select All. This command selects 
the entire sequence at once if chosen when the Song Editor is 
the active window. If the Step Editor or a MIDI Data Window is 
active, one entire track will be selected. See the description of 
the Select All command later in this chapter for details. 
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The Edit menu capabilities start with basic Cut, Copy, Paste, 
and Undo editing commands, much like those you'll find in 
other Apple figs programs. With Cut, Copy, and Paste, and a 
couple of supplemental commands, you can transfer data 
from any location in a sequence to any other location, or even 
to another sequence entirely. 

Before covering the Edit menu commands individually, there 
are a few things that you'll want to know about. One thing to 
be aware of is that some of the Edit commands work slightly 
differently depending on which window you're working with. 
Those differences are described with each of the commands. 

working with There will probably be times when you'll want to select 
tied notes regions in the Song Editor or Step Editor windows that include 

notes tied from the measure immediately before or after the 
selection. If the selected region begins on a measure 
boundary, Master Tracks Pro will recognize the tied notes 
when you use the Edit menu commands Cut, Copy, and 

about 
the 

clipboard 

Clear. . 

When you use one of these commands, the program 
removes or copies only the portion of the note that falls within 
the measures in which the selected region is located. With the 
Cut and Copy commands, this portion of the note is moved to 
the clipboard, and appropriate note-on and note-off events 
are added to it to make it a complete event. When you use Cut 
or Clear, the program also removes this portion of the note 
from the sequence, and inserts new note-on and note-off 
events for the parts of the note that remain. 

The clipboard is the temporary storage location for MIDI data 
that Master Tracks uses when you move or copy within a 
sequence, or from one sequence to another. For faster 
performance, the Master Tracks Pro clipboard is stored in 
RAM, the computer's internal memory, and not on disk like 
some Apple figs clipboard files. The effect of this is to speed 
up editing considerably. But there is a trade-off. The problem 
with this approach is that the data in the clipboard will be lost if 
you lose power or the computer fails for some other reason. 
Don't expect the clipboard file to be saved when you power 
down your computer. You must paste it into a sequence and 
save it using the File menu commands. 
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At the top of the Edit menu is the Undo command, which can 
also be executed by pressing Command-Z on the Apple fIgs 
keyboard. This command allows you to cancel the last 
alteration you made to your sequence with the commands on 
the Edit or Change menus. You may also Undo your most 
recent recording. Remember, though, that Undo only applies 
to the last change you made in the sequence. As soon as you 
use another Edit or Change command or start recording a 
new track, the change is now pemanent and can no longer be 
removed with Undo. 

Use the Cut command to remove MIDI data from the region 
you've selected, and place it in the Master Tracks Pro 
clipboard. You can execute the Cut command by choosing it 
from the Edit menu, or by pressing Command-X on the Apple 
I/gs keyboard. 

The exact way that data is removed by the Cut command 
depends on how you've selected the data: 

~ If you've selected one or more entire tracks in the Song 
Editor window, the Cut command removes their data 
entirely. 

~ If you've selected the entire sequence using the Select 
All command, or with the mouse in the Song Editor 
window, Cut removes all data. 

~ If you select one or more adjacent measures across all 
tracks in the sequence, the measures are completely 
removed and the remainder of the sequence is shifted 
to the left to fill in the gap. 

~ If you select a region within a track or tracks, but not all 
tracks in the song, Cut removes the data but leaves the 
measures intact. In other words, the rest of the data in 
the track(s) is not shifted to the left to fill in the gap. This 
is done to preserve the Conductor template across all 
the tracks. After this sort of cut, you'll see hollow 
measure bars indicating empty measures in the Song 
Editor window. 

Remember, a Cut command can be reversed with the Undo 
command. 
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Cut 
command 

specifics 

The Cut command and the various windows: 

~ On the Song Editor window, Cut works on all data types 
in the selected region. 

~ On the Step Editor window, Cut works only on note data. 

~ On a MIDI data window, Cut works only on the type of 
data displayed in that particular window. 

copying The Copy command makes a copy of the data in the selected 
region and puts it in the Master Tracks Pro clipboard. The 
existing data is not changed. In addition to selecting the Copy 
command with the mouse, you can also execute it by pressing 
Command-C on the Apple Ilgs keyboard. 

pasting 

The Copy command's effect varies, depending on which 
window you are working in: 

~ On the Song Editor window, Copy copies all data types 
to the clipboard. 

~ On the Step Editor window, Copy only copies note data. 

~ On a MIDI data window, Copy only copies the type of 
data displayed in the window. 

Paste places the contents of the clipboard into the sequence 
beginning at the location of the blinking cursor. You can 
choose the command with the mouse, or use Command-V 
from the Apple Ilgs keyboard. 

If the clipboard contains data from more than one track, data 
from the lowest numbered track in the clipboard goes into the 
track marked by the cursor. Data in the clipboard from 
subsequent tracks are automatically inserted into the next 
tracks in order. 
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To use Paste, first select an insert point by placing the cursor 
at the beginning of the measure where you want to insert the 
clipboard data. Then select the command. The data you 
paste in replaces any existing data in the sequence. (To 
merge the clipboard data with the existing data, use the Mix 
Data command.) 

You can paste data into empty tracks anywhere you like. Just 
position the cursor at the measure location where you want 
the pasted data to start, and execute the command. 
Remember, too, that you can Paste clipboard data from one 
sequence to an entirely different sequence if you wish. 

The Paste command works with the various windows as 
follows: 

~ On all windows, Paste places all the contents of the 
clipboard into the track, even if the clipboard includes 
data of another type than displayed in the active 
window. 

~ On the MIDI data windows, paste will only place the type 
of data cut or copied to the appropriate Data Window. 
(see Change Continuous to move from one Data type to 
another) 

~ On the Step Edit and MIDI Data windows, if the 
clipboard contains data from multiple tracks, you'll place 
data from the lowest # track only. 

clearing Clear works exactly like Cut, except that the data is removed 
without placing it in the clipboard. This gives you an 
alternative way to remove portions of your sequence. You 
may find it useful when you want to remove data from your 
sequence, but you don't want to erase the contents of the 
clipboard. 

To use the Clear command, choose it from the Edit menu 
after you've selected the region you want to clear. Alternately, 
you can simply press the delete key after selecting a region. 
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The Clear command and the various windows: 

~ On the Song Editor window, Clear removes all data 
types. 

~ On the Step Editor window, Clear only removes note 
data only. 

~ On a MIDI data window, Clear only removes the type of 
data displayed in the window. 

mixing The Mix Data command works identically to the Paste 
data command, except that the data in the clipboard that you're 

inserting in the sequence is merged with existing data already 
in the sequence. 

inserting 
measures 

To use the Mix Data command, first place the blinking cursor 
to the left of the first measure in the block where you want to 
place the clipboard data. Then choose the Mix Data 
command from the Edit menu, or type Command-M on the 
Apple figs keyboard. 

~ Only one track can be mixed at a time with another. So if 
you want to "bounce down" several tracks to a single 
track, you must do them one by one. 

With the Insert Measure command, you can lengthen the 
sequence by adding empty measures within it. You might use 
this command to insert a new section into the middle of a 
composition or to add a blank space or countdown to the 
beginning. 

You can use the Insert Measure command from the Song 
Editor, Step Editor, or MIDI data windows. No matter which 
window you're working in, you may insert measures in all the 
tracks in the sequence, or only a single track. The newly 
inserted measures will all have the same meter and tempo as 
the last measure prior to the inserted section. Use the Change 
Conductor command in the Change menu to alter these 
timing settings. 
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When you choose Insert Measure, or type Command-Ion the 
Apple figs keyboard, a dialog box pops up on screen. Type in 
the number of measures you wish to insert, and if you wish to 
affect all tracks or just a single track. Click on OK or press 
Return to confirm your entry. Click on Cancel to return without 
inserting measures. 

Insert Measure 

Insert II I measure(s) before measure 14. 

@ RII tracks 

o Only on track [!:] 

n Ok ]1 ( Cancel] 

The steps you'll take to use the Insert Measure command 
vary slightly depending on whether the Song Editor window or 
the Step Editor window is currently active. 

In the Song Editor window, place the cursor at the beginning 
of the measure before which you want to insert the new 
measure(s). After executing the command, the new 
measures will appear on the screen as hollow measure 
boxes, indicating they are empty of MIDI data, with the cursor 
positioned at the beginning of the first measure in the inserted 
group. All the remaining measures in the sequence will have 
been pushed to the right and renumbered. 

For example, say you want to insert two measures beginning 
after the eighth measure in the sequence, and just before 
what's now the ninth measure. Place the cursor between the 
eighth and ninth measures and select the Insert Measure 
command. Once you've completed the insertion, the newly 
inserted measures will be measures nine and ten, while what 
was formerly measure nine will now be measure eleven. 

In the Step Editor window, use the arrow pointer to select any 
region in the measure before which you want to insert the 
new measure(s), and then give the command. After a brief 
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pause, you'll see the new empty measure(s) on the screen, 
and the remaining measures will be renumbered to reflect the 
insertion. 

select The Select All command lets you select the entire sequence 
all or track for use with the editing commands. From the Song 

Editor window, just choose Select All from the Edit menu, or 
type Command-A on the Apple figs keyboard - the entire 
song will be selected. 

In the Step Editor and MIDI data windows, Select All selects 
the entire track you're working with. 

show/hide Show Clipboard pops up a small window which describes the 
clipboard current contents of Master Tracks Pro's clipboard. The 

window tells you which tracks and bars the data was copied 
from, how long the data lasts in bars (measures), beats, and 
clock ticks, and whether the data was cut or copied. 

Clipboard 
Data was copied: 

From: Track 1 
Bar 4 Beat 1 Clock 0 

Thru: Track 2 
Bar 7 Beat 4 Clock 39 

The Clipboard window remains on screen until you close it, 
although it's likely to get buried under other screen windows. If 
you like, you can leave the clipboard window open on the 
screen. If it gets hidden behind other windows, however, you 
must either move or close them to see the clipboard window 
again, or choose Show Clipboard from the Edit menu. 



While the Edit menu commands let you move or delete 
regions of notes, the Change Menu contains commands that 
allow you to regionally alter MIDI and timing data in many 
sophisticated ways. All of the Change menu commands work 
on any region you select in the Song Editor, Step Editor, or 
MIDI data windows. 

Included are commands for changing note duration, note 
velocity, continuous MIDI data, and tempo and meter in the 
selected region. There are also commands for stripping 
different types of data out of a track, transposing pitch, and 
for changing the rhythmic relationships of MIDI events. 

Duration .. . 
Uelocity .. . 
Continuous .. . 
Conductor .. . 

Strip Data .. . 
Transpose .. . 

Humanize .. . 
Quantize .. . 

As with Edit menu commands, you must first select a region 
before you can use the Change commands. To select a 
region, use the mouse as described in the chapters on the 
Song Editor, Step Editor, and MIDI data windows. 
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change Choosing the Duration ... command pops up a dialog box that 
duration allows you to alter the duration of each note in the region­

how long it plays. 

The dialog box gives you two choices for changing note 
durations. 

The first option in the box lets you set all notes in the region to 
a specified duration. Activate this option by clicking in the 
circle next to it. A solid black dot appears within the circle 
when the option is selected. 

Next, select the duration you wish by using the arrow controls 
to choose the appropriate note duration icon. 

To select a tuplet resolution, click on the box next to "Tuplet," 
and enter the tuplet values you wish by clicking on the 
appropriate boxes and typing in the new numbers. 

Based on the duration you choose, the number of clock ticks 
each note will receive in the region appears in a box.to the 
right of the arrow controls. If you prefer, you can type in any 
duration value, expressed in clock ticks, you wish into this 
box. 

Change Duration 

@ Set all ualues to I J! 181 ~ 0 Tuplet [J: ~ I 
o Chonge to ~ '7. of current volues 

[ OK [ Concel ) 

The second option in the Change Duration dialog box allows 
you to scale all duration values in the selected region by a 
percenta!;le of their current values. Again, click on the circle 
beside this option to select it, so that the solid black dot 
appears. Now type in the percentage of the current duration 
values, within the range of 1 to 999%, you wish to use. With 
this option, the relative timing of all the notes is preserved. 

After selecting the option you wish, Click on OK or press 
Return to complete the command, or click on Cancel to return 
to your work without making any changes. 



change 
velocity 
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The Dialog box that pops up when you choose the Velocity ... 
command lets you change the velocity values for all notes in 
a selected region. 

Change Uelocity 

@ On Uelocities 0 Off Uelocities 

@ Set all uelocities to 1.0 
o Change to 0 % of current ualues 

o Change smoothly from ~ to ~ 

o Add D to all ualues 

OK [ Cancel 1 

Changing velocity is useful for adding punches to a track or to 
mix the loudness of a track or passage relative to other 
tracks. It can also be used to bring velocity values up or down 
over time to create swells, crescendos, and decrescendos. 

First, you need to decide whether your changes will apply to 
note-on velocities, note-off velocities, or both. Click over the 
circle to the right of one or both of these choices in the dialog 
box. Please note that many synthesizers do not transmit or 
recognize note-off velocities. 

Next, you can decide from among four options for altering the 
velocity values. Click over the circle next to the option you 
select: 

1. You can set all velocity values in the region to a specific 
value. 

2. You can change all velocity values by a specific 
percentage. 

3. You can have all velocity values in the region change 
smoothly from one value at the beginning of the region 
to another value at the end of the region. 

4. You can add or subtract (with a minus value) a set 
amount to all velocity values in the region. 
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After selecting which of these four options you wish, click on 
the appropriate data box(es) for that option and type in the 
value or percentage you've chosen. Click on OK or press 
Return to enter the value. 

Valid MIDI velocity values are between 1 and 127. A velocity 
value of "0" is the same as a "note off" command. If you enter 
a velocity value below 1 or above 127 in options 1 or 3 above, 
Master Tracks Pro will tell you that the value is out of range. 
You'll then be returned to to the Change Velocity dialog box 
with a highlight on the invalid value. If the values you've 
entered in options 2 or 4 throw existing velocity values out of 
the valid range, Master Tracks Pro will clip them to 1 or 127 
as appropriate. 

change Choosing the Continuous ... command brings up a powerful 
continuous dialog box that lets you alter data from any continuous MIDI 

controller, such as a pitch bend wheel, a modulation wheel, 
aftertouch (channel pressure), or any numbered MIDI 
controller. You can use this command to map data from one 
MIDI controller to another, change the values of the controller 
data, or both. 

Change Continuous Data 

Selett Doto Type o Mop Doto Type To 
o Pltth Bend 
o Modulotion 
o Channel Pressure 
@ Controller # D 
181 Chonge Ooto Uolues 

o Pitch Bend 
o Modulotion 
o Chonnel Pressure 
@ Controller # 0 

@ Set all uolues to 0 
o chonge to D % of current uolues 

o change smoothly from 0 to 0 
o ndd 0 to 011 uolues 

mapping By mapping one type of MIDI data to another type, you can 
data send data recorded from one controller to a MIDI device that 

responds to a different controller. For instance you can map 
channel pressure information to mod wheel if you like. 
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To map one data type to another, first select the type of data 
you wish to operate on in the selected region from the 
choices listed under "Select Data Type" at the top of the 
dialog box. Click on the circle next to the choice you select so 
that a smaller solid black circle appears. If you've chosen the 
Controller # option, you must also type in its number in the 
corresponding box. 

Next, click in the box labeled "Map Data Type To" at the right 
of the dialog box. An "X" will appear in the box. Now choose 
the data type to which you want to map the existing data by 
clicking in the circle next to your choice. Again, you must type 
in a number if you select the Controller # option. See Chapter 
14 for a list of Controller numbers. 

changing To change data values, you must first select the type of data 
data values you wish to work on, if you haven't done so already, as 

described above. Next, click in the box labeled "Change Data 
Values" so that an "x" appears in the box. You now have four 
choices: 

note: 

1. You can set all values in the region to a specific value. 

2. You can change all values by a specific percentage. 

3. You can have all values in the region change smoothly 
from one value at the beginning of the region to 
another value at the end of the region. 

4. You can add or subtract (with a minus value) a set 
amount to all values in the region. 

After selecting which of these four options you wish, click on 
the appropriate data box(es) for that option and type in the 
value or percentage you've chosen. 

If you are mapping data to another controller at the same 
time you are changing data values, the changed values will 
apply to the controller to which you are remapping the data. 
Once you've made all your choices, click on OK or press 
Return to complete the command. Click on Cancel at any 
time to exit the dialog box without making any changes. 
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change Master Tracks Pro has a separate Conductor track with 
conductor which you can determine the rhythmic structure of your entire 

sequence. All tracks in the sequence follow the settings in the 
Conductor track for meter, tempo, and the type of note that 
gets the beat, but you can vary these settings from measure 
to measure as often as you like. You can even change 
tempos gradually for ritardandos and accelerandos. 

note: 

The vertical grey bar in the Song Editor window represents 
the end of the Conductor track. 

Choose the Conductor ... command on the Change menu to 
bring up the Change Conductor dialog box. 

Chonge Conductor 

From Mensure 0 10 §:=J 

o Sel Meter to ~ nnd Beot to [E 
@ Set all Tempos 10 ~ 

o change 10 D % of current unlues 

o Change smoothly from ~ to ~ 

o ndd D to all unlues 

Unlike other Change menu commands, you don't have to 
select a region before you use the Conductor command. If 
you have selected a region, however, the first and last 
measures in the region will appear in the appropriate boxes 
at the top of the dialog box. You can define a new region by 
typing in different measure numbers. 

changing If you wish to set the meter or beat note for the region, click 
meter on the circle next to that option in the dialog box. Then type in 

the new meter values. Select the note icon for the beat note 
with the arrow controls at the right. In 4/4 time, if a quarter 
note beat is selected, you will hear 4 beeps per measure from 
the metronome with an accent on each first beat and you will 
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conductor 
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see four main divisions in each measure in the Step Edit 
Window. If you change the beat to an eighth note, you will 
now hear 8 beeps per measure and see 8 main divisions per 
measure. Tempo will now be half speed since it is measured 
in "beats" per minute so you may wish to double the tempo for 
this region. 

You have four options for setting a new tempo in the region: 

1. You can set all tempo values in the region to a specific 
value. 

2. You can change all tempo values by a specific 
percentage. 

3. You can have all tempo values in the region change 
smoothly from one value at the beginning of the region 
to another value at the end of the region. 

4. You can add or subtract (with a minus value) a set 
amount to all tempo values in the region. 

After selecting which of these four options you wish, click on 
the appropriate data box(es) for that option and type in the 
value or percentage you've chosen. The range of permissible 
values for tempo setting is 10 to 300 with beat set to quarter 
note, but with beat set to sixteenth note, tempos can be up to 
1200 BPM. If you enter a value outside this range with option 
1 or 3, Master Tracks Pro will highlight the illegal value and 
ask you to change it before you can return to your work. Any 
existing tempo values changed by options 2 or 4 so that they 
are out of range will be truncated to the maximum or 
minimum values. 

Click on OK or press Return to complete the Conductor 
command. Click on Cancel to exit the dialog without making 
any changes. 

The Conductor track allows you to have multiple meters in 
the same song. One way to use multiple meters is to create 
the rhythmic structure of your sequence with the Conductor 
track before you record any music. The Conductor track is 
equivalent to a "tempo map" and a "meter map" combined 
into a single structure. Use the Conductor command to define 
meter and tempo for each section in turn. Once you've 
created this Conductor template, you can record your music, 



10-8 Master Tracks Pro 

and the program will automatically shift meters at the correct 
measures as you record. 

To see how this process works, try this example: First, select 
New from the File menu to clear the Apple figs's memory. 
Now choose the Conductor command from the Change 
menu. Set bars 1 to 4 to a 4/4 meter at 100 beats per minute 
with a quarter note beat. Now choose the Conductor 
command again, and set bars 5 to 8 to 3/4 at 140 beats per 
minute. Choose the command a third time, and set bars 9 to 
12 to 214 at 80 bpm. 

In the Song Editor window, you'll now see that you have a 12 
bar score. If you move the transport with the fast forward 
button, or "play" the empty sequence, you'll see the tempo 
and meter settings in the Conductor Window change as you 
reach each new section of the Conductor track. You can view 
the Conductor track graphically by pressing Command-O or 
choosing Conductor from the Windows menu. 

If you wish, you can save a Conductor track template as a 
disk file before you enter any music, and use it for as many 
separate sequences as you like. 

strip The Strip Data command lets you cut or copy selected types 
data of MIDI data from the edit region. Among the types of data 

you can cut or copy are data from a particular MIDI channel, 
various types of MIDI controller data, or a range of notes. 

You can select any combination of these data types each 
timeJou use the Strip Data command. For example, you 
coul copy only notes above middle C and pitch bend data, 
both from channel #4. 

The selected data types are cut or copied to the clipboard. 
You can then place them back into your sequence anywhere 
you like using the Paste or Mix Data commands on the Edit 
menu. 

By selecting various ranges of notes, you can use the Strip 
Data command to create as many keyboard "splits" as you 
like. The command can also help conserve memory by 
removing unnecessary controller data (such as unintentional 
channel pressure or aftertouch) while leaving other data 
intact. 
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Select a region and choose Strip Data ... from the Change 
menu. Click in the box or boxes next to the data type(s) that 
you wish to cut or copy with the command. If you select the 
Controllers option, you can either cut or copy all numbered 
MIDI controllers, or you can select a specific controller 
number. 

Similarly, you can either select all notes in the edit region, or 
only notes in the range you enter. To enter note pitches to 
define the range, you can either type in the pitch or play the 
corresponding key on the MIDI keyboard. If you type in the 
pitch, enter the pitch letter name, a # sign if the pitch is an 
accidental, and the octave number. 

note:~m\~~l~\~fi&j 

Finally, decide whether you want to cut or copy the selected 
data types, and click in the circle next to the option you 
choose. If you select Cut, the selected data types in the 
region will be removed from the sequence and placed in the 
clipboard. If you select Copy, a copy of the data will be placed 
in the clipboard, while the original data remains intact. 

Strip Ooto 

o Only on chonnol ~ 

IZI Pitch Hend IZI f\1mHHHtion 
!1!l Ch~mel Pressure !1!l Program Change 
[gI Polyphonic Key Pressure 

[gI Controllers 
o onlY controller # ~ 

IZI Notes 
o Only notes between § ond ~ 

( OK @Cut o CoPy ( Concel 1 

When you've finished making all your selections in the Strip 
Data dialog box, click on OK or press Return (or Enter) on the 
Apple I/gs keyboard. Click on Cancel instead to exit without 
making any changes. 
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additional 
method for 

copy/cutting 
data 

transpose The Transpose command changes the pitch of all the notes 
in the selected region from one key to another. The 
Transpose command recognizes individual clock ticks, so 
you can use it on regions that include portions of measures. 

Transpose I 
Tronspose notes from [§J to ~ 

DO !m [ Concel) I 
When you choose this command, a dialog box appears, and 
you are asked to enter the key from which you are 
transposing, and the new key to which you want to transpose. 

To enter these keys, click on the app'ropriate box, and then 
type in a pitch letter name, a # sign If you're entering an 
accidental, and the octave number or play the appropriate 
note on your MIDI keyboard. Valid pitches range between 
C-2 and G8. You must enter all accidentals as sharps. 

Press Return or click on OK to enter the transposition and 
return to your work. Click on Cancel to exit without making 
any changes. 

humanize The Humanize command is designed to make your 
sequence less machine-like and rigid by randomly shifting 
the start time, duration, and/or velocity of each note in the 
selected region. 

Jr===================~ 
Humonize 

o Randomize start times within 0 clocks 

o Randomize durations within 0 clocks 

o Randomize uelocltles within 0 uolues 
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When you select the Humanize command, a dialog box 
appears that lets you choose whether to apply the 
randomization effect to start times, durations, or velocities. 
Click on the box next to each option you want to select. 
Next, you must enter a maximum value to tell the program 
how large the random changes can be. The Humanize 
command will add or subtract a random amount from each 
note in the region, but only within the range set by this value. 
In the case of start times and durations, type in the maximum 
number of clock ticks that will be added or subtracted to 
existing values when the Humanize command goes to work. 
For velocities, the maximum value is simply a numeric value 
between 1 and 127. 

In practice, very small values work best for achieving subtle 
variations in highly mechanical music. Large values will 
produce wide and random changes that are sometimes 
useful, but not at all predictable. 

When you've made your selections, click on OK or press 
Return to enter them and complete the command. Or click on 
Cancel to exit without making any changes. 

The Quantize command aligns the start times of all notes and 
other MIDI events in the selected region to an imaginary 
timing "grid." The grid divides the region into intervals of a set 
number of clock ticks. When you use Quantize, the start time 
of every note is moved within the region so that it falls 
precisely at the begining of the nearest grid interval. You can 
choose to Quantize the entire note or just the attack times, 
leaving the note offs at their current locations. This could be 
used to create a more accurate rhythm while preserving 
release times of envelopes on synthesizers. 

Of course, you'll usually quantize to a grid based on a 
standard note type, such as to the closest quarter or 
sixteenth note. But Master Tracks Pro gives you the freedom 
to quantize to any interval you wish. 

Master Tracks Pro defaults to a Quantize setting of 35% 
ahead of the beat. In other words, if you are quantizing to 
16th note values, it will include (shift, align) any notes which 
fall from 35% before the current 16th note and up to 65% 
behind the current 16th note. If a note falls more than 35% 
early, it will be quantized to the previous 16th note position. 

This range can be adjusted to your specific situation by 
entering a different value in the percentage box. If you tend to 
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"slide" 
(shift start 

times) 

rush a particular passage you may wish to set the range to 
include notes that fall a larger percentage ahead of the beat. 
The intensity (degree) of quantization is also adjustable. It 
has a default value of 100 %, meaning that notes will be 
quantized fully to the note or tick interval you specify. An 
intensity setting of 50% would move notes only half the 
distance to the nearest specified interval. 

Quantize 

o Enlire note @lIttacko only 

Il!l Quantl20 to l.ll lSI §:=J D Tuplel @]: ~ I 
InclUde notes up to §] % oheod of the boot. 

Iulouilty ~ 7. 

o Slide notes r!::J cluck. ttl the 0 lelt G> right 

The Quantize command also allows you to shift start times in 
the quantized region slightly away from the grid interval. This 
feature is valuable for creating passages that are a little 
ahead of or behind the beat, sliding the notes in a track. 

Begin by choosing Quantize from the Change menu to bring 
up the Quantize dialog box. Then select the quantization 
value by using the arrow controls to choose the 
corresponding note duration icon. To select a tuplet 
resolution, click on the box next to "Tuplet." Then enter the 
tuplet values you wish by clicking on the appropriate boxes 
and typing in the numbers. 

Based on the duration you choose, the number of clock ticks 
in each note value will appear in a box to the right of the 
arrow controls. If you prefer, you can simply type in any 
duration value you wish in this box. If you wish to slide notes 
without quantizing them, click in the box next to the words 
"Quantize to", removing the "x" from it. 

If you wish to select an offset for quantization, click on the box 
for the "slide notes" option so that an "x" appears in the box. 
Decide whether you want to slide notes before(left} or after 
(right) the grid boundaries, and click on the circle next to 
your choice. Finally, type in the number of clock ticks that you 
want for the offset (48 per quarter note). 

When you've entered your selections, click on OK or press 
Return to complete the Quantize command. If you wish, you 
can click on Cancel to exit without making any changes. 
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';Conductor 
Transport 

The Windows menu provides access to any of the main 
Master Tracks Pro data windows. If a window is not currently 
on the screen, or if it is hidden behind other windows, you 
can bring it to the front and activate it from the Windows 
menu in one of two ways . 

• You can choose the window you wish by name from 
the Windows menu 

• You can press a Command-key sequence on your 
Apple figs keyboard. 
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Here's a brief description of each of the main Master Tracks 
Pro windows, including the Command-key sequence you can 
use to call up the window from the Apple figs keyboard: 

track sheet ~ Command-1 

The Track Sheet window allows you to see and name all the 
tracks in your sequence. In addition, it lets you choose which 
tracks play, record, solo, and loop. You can also enter MIDI 
channel settings and initial MIDI program numbers for each 
track in the sequence. 

song editor ~ Command-2 

The Song Editor window provides a graphic display of your 
sequence in units of measures, and shows you where the end 
of the sequence falls. Blocks of measures can be selected 
and edited with a variety of powerful commands. You can 
place and display markers that allow to quickly find specific 
places in your sequence. 

step editor ~ Command-3 

The Step Editor window lets you see and edit MIDI note data 
graphically. You can input, move, copy, and erase individual 
notes anywhere on the graph, and you can also edit note 
parameters numerically. In addition, you can use a step 
method for note entry, and you can select regions of notes for 
editing operations. 

pitch bend ~ Command- 4: 

channel 
pressure 

(aftertouch) 

The Pitch Bend window allows you to display and edit pitch 
bend data. You can enter, edit, and erase individual pitch 
bend events, and you can draw in consecutive events 
graphically. You can also select regions of pitch bend events 
for editing operations. 

~ Command-5 

The Channel Pressure window lets you work with MIDI 
channel pressure data, also called monophonic aftertouch. 
Usin~ a graph in the window, you can add, edit, and erase 
individual channel pressure events, and you can also draw 
them in consecutively on the graph. Regions of channel 
pressure events can be selected for editing operations as 
well. 
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key pressure ~ Command-6 

The Key Pressure window is the window for displaying and 
working with MIDI key pressure data, also called polyphonic 
aftertouch. You can enter, change, or erase key pressure 
events on the graph in the window, draw in consecutive 
events, or select regions of events for editing operations. 

modulation ~ Command-7 (Controller #1) 

The Modulation window lets you display and edit MIDI 
modulation data which usually corresponds to the mod wheel 
on your synthesizer. The graph lets you input, edit, or erase 
modulation events, draw them in as a group, and select 
events in regions for editing operations. 

controllers ~ Command-8 

program 
change 

conductor track 
data window 

The Controllers window lets you enter and edit data for any 
MIDI controller. Using the graph in the window, you can enter, 
edit, or erase individual controller events, draw them in 
consecutively, and select them in regions of editing 
operations. (see the MIDI Controller list pg. 11-4, following) 

~ Command-9 

The Program Change window lets you see and edit MIDI 
program change events within your sequence. You can 
Insert, edit, or erase individual program change events, you 
can select them regionally for editing operations. 

~ Command-O 

The Conductor Track Edit window lets you view and edit the 
Conductor track graphically. Basic changes to the conductor 
track such as smooth tempo transitions over time and 

. re-barring of sections should be made in the Conductor 
dialog box from the Change menu. The Conductor Track Edit 
window is intended for viewing and making fine adjustments 
to the tempo. Tempo values can be entered on any clock tick 
with the pencil and erased with the eraser. Tempo values 
occur at every measure and these can be changed with the 
pencil but cannot be erased. They will change automatically 
to reflect any changes made in the Conductor dialog. 
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list of MIDI 
controllers 

I MOST COMMONLY USED MIDI CONTROLLERSI 

CONTROLLER #1 
CONTROLLER #2 
CONTROLLER #4 
CONTROLLER #5 
CONTROLLER #6 
CONTROLLER #7 
CONTROLLER #8 
CONTROLLER #10 
CONTROLLER #64 
CONTROLLER #65 
CONTROLLER #66 
CONTROLLER #67 
CONTROLLER #92 
CONTROLLER #93 
CONTROLLER #94 
CONTROLLER #95 
CONTROLLER #96 
CONTROLLER #97 
CONTROLLER #122 
CONTROLLER #123 
CONTROLLER #124 
CONTROLLER #125 
CONTROLLER #126 
CONTROLLER #127 

MODULATION WHEEL 
BREATH CONTROLLER 
FOOT MODULATION 
PORTAMENTO TIME 
DATA ENTRY SLIDER 
MAIN VOLUME 
BALANCE 
PAN 
SUSTAIN (DAMPER PEDAL) 
PORTAMENTO 
SOSTENUTO (MIDDLE PEDAL) 
SOFT PEDAL 
TREMELO DEPTH 
CHORUS DEPTH 
CELESTE (DETUNE) DEPTH 
PHASER DEPTH 
DATA INCREMENT 
DATA DECREMENT 
LOCAL CONTROL (OFF=O,ON=127) 
ALL NOTES OFF 
OMNI MODE OFF 
OMNIMODEON 
MONO MODE ON 
POLY MODE ON 



follow playback 

.,IFoliow Playback 

Zoom In 3€( 
Zoom Out 3€] 

The Layout Menu contains commands that determine the 
appearance of data windows. These commands can 
influence your interaction with the program in important ways. 

When the Follow Playback feature is active, the Song Editor, 
Step Editor, and MIDI Data windows scroll as the sequence 
plays, displaying a highliQht to indicate the measure that is 
currently playing. With thIs feature off, these windows remain 
as you left them during sequence playback. 

To activate the Follow Playback feature, choose it on the 
Layout menu. When the feature is active, a checkmark 
appears next to it on the menu. 

To deactivate Follow Playback, simply choose it again. The 
check mark will disappear. When Follow Playback is 
deactivated, you can scroll to and examine any location in any 
window independently of the playback transport position. 
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zoom The Zoom commands let you choose how much data you see 
in/out in the Step Editor and MIDI Data windows. To get the big 

picture on your sequence, use the Zoom Out command to 
place more measures on the window. For precise work, use 
the Zoom In command to show a smaller amount of the 
sequence at higher "magnification." Four separate levels of 
zoom are available, so you can easily adjust the display to fit 
your needs. 

The Zoom level set by the Zoom In and Zoom Out commands 
also determines the number of clock ticks displayed per pixel 
on the screen, and thus affects the resolution at which you 
can edit data in the Step Editor and MIDI data windows. 

If you zoom all the way in to the maximum level of 
magnification, each pixel represents a single clock tick. This is 
the best level for precise work when you're editing notes, 
pitch bend, or other MIDI data. . 

When you zoom further out, the clock tick-per-pixel value 
increases. 

When you move the cursor in one of the windows, it is 
"snapped" to an imaginary grid with divisions at 1 clock tick per 
pixel, 2 per pixel, and so on, up to a maximum of 4 when 
you're zoomed all the way out. (a pixel is the smallest dot on 
the figs screen and the minimum distance interval you can 
move your mouse) You can use this feature to do a kind of 
manual "quantizing" of notes and other events in the Step 
Editor and MIDI data windows. Just click on the note or event 
with the crosshair (pencil), and the event will automatically be 
moved to the nearest division of the imaginary grid. 

You may also want to zoom out when you are inputting pitch 
bend or other continuous controller data to economize on 
memory, and to reduce the rate at which the sequence must 
send data. If you input pitch bend data when you're zoomed 
all the way in, you create 4 times as much data as when 
you're zoomed all the way out! 

To zoom in one level, choose the Zoom In command or press 
Command-[ on the Ilgs keyboard. To zoom put, choose Zoom 
Out or press Command-]. Using either command affects all 
the data windows on screen. 

If your song contains time signatures with bottom numbers 
smaller than 1/8 note, the Zoom Level will be constrained. 



display 
memory 

use 

III • 

Memory 

Keyboard... OK 
Midi Setup ... 

Record Filter... OR 

The Goodies menu gives you a set of commands for tailoring 
Master Tracks Pro to your own system, and for controlling the 
sequencer from your MIDI keyboard. 

Selecting Memory brings up a small window that shows how 
much memory, in bytes, that your score is using, how much 
memory is being used by Master Tracks Pro's clipboard, and 
how much memory is still available. The memory window will 
remain on the screen until you close it, or cover it with another 
window. Bring it to the front by selecting Memory again. 

l§D§Memory 
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MIDI 
keyboard 

setup 

Selecting the Keyboard command brings up a dialog box that 
lets you configure Master Tracks Pro for MIDI keyboard 
control of these functions. When you've made your 
configuration settings, click on OK to enter them and return to 
the program, or click on Cancel to return without entering the 
changes. 

MIDI Keyboard Setup 

D Use in Tronsport D Use in Step Input 

o Ploy Key 

~ 
Do@] Dol§] 

o Stop Key 01 OJ§] O.ll§] 
o Record ~ DJ~ O.ll§] 
o Rewind ~ OJ'§] o 'IC#21 
DFostFwd ~ o Tuplet 1 G#21 
D Pause Key [!IJ 

ORest IR#21 

MIDI transport The options for transport control are at the left side of the 
control Keyboard command dialog box. To activate MIDI keyboard 

control of the transport functions, click on the small box next 
to "Use in Transport" in the dialog box. An "x" will appear in the 
box when MIDI keyboard control of the sequencer transport 
is active. You can turn it off again at any time by clicking on 
the box again. 

using the MIDI 
keyboard for 
step editing 

note: 

Next, assign each transport function in the list (play, stop, 
record, and so on) to a key on your MIDI keyboard. Click on 
the larger box to the right of each function and then play the 
key to which you want to assign that function. Alternately, you 
can type in the pitch letter name and octave number. 

In addition to entering the key you'll use to control each 
transport function, you must also activate keyboard control of 
each function individually by clicking over the small box to the 
left of the function name. When the keyboard control is active, 
an "x" appears in the box. You can deactivate any function 
simply by clicking on the box again. Being able to activate the 
functions individually allows you to use only the ones you 
really need, leaving you more keys to play. 
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The chapter on the Step Editor describes how to use your 
MIDI keyboard to insert new notes in the sequence. To 
activate MIDI keyboard control of the duration of the inserted 
notes, click on the box next to "Use in Step Input." An "x" will 
appear in the box indicating that keyboard control of note 
durations is now active. You can turn it off again by clicking 
over the box once more. 

You can specify which key you wish to use for each duration 
value by clicking over the box to the right of the corresponding 
note icon, and then playing the key on your MIDI keyboard, or 
typing in the pitch letter name and octave number. Using the 
same method, you can also specify a key to activate the tuplet 
function, and one to insert a rest equal to the currently 
selected duration. 

Once you've made your keyboard assignments, you must 
also activate each key separately by clicking over the box to 
the right of its duration icon. Again, you can deactivate any 
key by clicking over the box another time. By activating only 
the keys for the durations you need, you'll save keys for 
recording music. 

The MIDI Setup command lets you choose which Apple figs 
port your MIDI interface is connected to, and whether Master 
Tracks Pro uses its own internal clock for sync timing, or 
follows an external MIDI clock source. 

MIDI Setup 

Port Sync 

@ Modem @ Internlll 

o Printer o MIDI 

U OK l) [ Cllncel 1 

Selecting the command brings up a dialog box that lets you 
make these choices. Once you've made your changes, click 
on OK to to enter them and return to the program, or click on 
Cancel to exit without saving your changes. 
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assigning MIDI 
data port 

selecting 
internal/external 

timing 

Master Tracks Pro allows you to use either the modem or 
printer port for your MIDI interface. To do so, simply click on 
the appropriate circle on the left side of the MIDI Setup dialog 
box. A smaller solid black circle will appear within the circle 
when the selection is made. 

The timing of a Master Tracks Pro sequence can be set by its 
own internal clock or by an external MIDI clock. If you use an 
external MIDI source for timing, Master Tracks Pro responds 
to all MIDI timing messages, including Start, Stop, Continue, 
Song Pointer, and MIDI clocks. 

To set the sync source to the program's internal clock, click 
over the circle next to "Internal" on the right side of the MIDI 
Setup dialog box. 

If you want to sync the sequence to an external MIDI clock 
source, click instead on the circle next to " MIDI" in the dialog 
box. 

using the Master Tracks Pro can selectively record only the MIDI data 
record filter you wish, while it filters out any data that you don't want to 

record. Choose the Record Filter command on the Goodies 
menu to bring up a dialog box that lets you choose which 
combination of MIDI data types Master Tracks Pro will record. 

With this feature, you can independently select or disable 
each MIDI data type, including pitch bend, channel pressure 
(also known as monophonic key pressure or aftertouch), 
polyphonic key pressure, modulation, program changes, note 
data, and other MIDI controllers. 

You can also have the program quantize note timing while 
you are recording. 

As a simple example, you may want to conserve memory by 
filtering out aftertouch or modulation wheel data (since both 
of these controllers send data continuously, they can quickly 
fill up large amounts of your system memory). Filtering out the 
aftertouch and mod wheel data is a simple matter of 
deactivating these options on the Record Filter dialog box. 
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You can choose not to record notes at all, so that you can 
create a separate track for, say, pitch bend data. That way, 
you can concentrate on making your pitch bends as accurate 
as possible. You can choose a single channel that Master 
Tracks Pro will "listen to" while recording, while it ignores 
incoming data on other channels. You can also quantize on 
input as many drum Machines do. 

Record Filter 

Select type of data to be recorded 

~ Notlls 
121 Pitch Dend 

121 Channel Pressure 

121 Polyphonic Key Pressure 

o Only on chonnel [] 

~ Controllgrs 
121 Modulation 

121 Program Change 

o Quantize to I ~ !gJ ~ D Tupillt @]: [I] I 
Shift all notes up to ~ % ahead of the beat. 

OK ( Cantel J 

changing To change the Record Filter settings, first choose Record 
record filter Filter on the Goodies menu. In response, the Record Filter 

settings dialog box appears. 

Each MIDI data type appears in the dialog box with a 
corresponding box to the left of its name. When an "x" 
appears in the box, that data type will be recorded. When the 
box is empty, that data type is disabled, and it will be ignored 
during recording. You can select or disable any combination 
of data types you wish. Clicking on the boxes toggles them 
between the selected and disabled settings. 

miscellaneous The Controllers option in the Record Filter dialog box refers to 
controllers all miscellaneous MIDI controllers other than the ones 

specifically listed in the box. Consult your synthesizer owner's 
manual for the numbers of any controllers that your 
instrument can send or receive. 
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selecting Another choice on the Record Filter dialog box, "Only on 
individual Channel" allows you to filter out data from all but one MIDI 

channels on the channel when you record. When this setting is active, the box 
record filter beside it contains an "x". You can deactivate this option by 

clicking on the box beside so that it is empty, and data from all 
channels will be recorded. 

If you wish to use this option, enter the channel number by 
clickinQ on the data box on the right of the option, and then 
typing In the channel number, from 1 to 16. 

quantizing You can use the option on the Record Filter labeled "Quantize 
while to" to quantize notes while you record them, much as a drum 

recording machine does. 

exiting the 
record filter 

Activate this option by clicking in the box next to it. An "x" 
appears in the box when it is active. 

Next, select the resolution for quantization by using the arrow 
keys to choose the appropriate note duration icon. To 
quantize to a tuplet resolution, click on the box next to 
"Tuplet," and enter the tuplet values you wish by clicking on 
the value boxes and typing in the new numbers. You may 
also change the percentage value that determines how far 
ahead of the beat Master Tracks Pro will reach to quantize a 
note. (see chap. 10 Quantize) 

When you're finished making your Record Filter selections, 
return to the main Master Tracks Pro screen by clicking on 
OK. Any settings you make in the Record Filter can be saved 
using the Preferences command in the File menu. To return 
without entering the changes you made, click on Cancel. 



conductor 
track settings 

re-barring 
to remove 

a beat 

In this chapter you'll find information about how you can put 
Master Tracks Pro to work on your most sophisticated 
musical chores, including looping, punch in recording, MIDI 
and SMPTE sync, and more. 

The program stores tempo, beat and meter values in a 
separate "Conductor Track" along with each measure in the 
score, providing an elegant way of setting up conductor 
"templates" of meter and tempo changes. These values are 
stored in the Conductor Track and control how the MIDI data 
is broken up into measures. Conductor templates can be 
saved to disk as a score for later use. The vertical grey bar in 
the Song Editor represents the end of the Conductor Track. 

The Conductor track can be utilized to remove measures or 
even a single beat from your sequence. For example, if you 
have a 4/4 measure in your piece (say measure 6) which you 
have decided needs the last beat removed. Select measure 6 
and choose Conductor from the Change Menu. Change the 
meter of measure 6 from 4/4 to 1/4 time. Now when you 
return to the Song Editor Window or Step Editor Window you 
will see 4 measures occupying the space previously taken up 
by measure 6. This is most graphically depicted in the Step 
Editor Window. Each of these four new measures now 
contains only one beat. In the Song Editor Window, Cut the 
last of these new measures (#9) by selecting it along the 
measure ruler at the top of the window. Selecting measures in 
this manner cuts time out of the sequence on all 64 tracks and 
includes the Conductor Track. You can now select the 3 
remaining 1/4 measures (#6 - #8) and choose Conductor 
once again from the Change Menu and rebar those three 
measures to 3/4 time making them one measure again. 
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conductor track The Conductor Track Edit Window (Command-D) shows a 
data window graphic representation of the conductor track. This is 

intended as a means of viewing the Conductor Track and 
making "fine tuning" changes. Basic changes to the 
Conductor Track should be made from the Change menu 
using the Conductor dialog box. The graphic in the 
Conductor Track Data Window is scaled to the beat value so 
that it can be displayed on one screen. So, if the beat value 
changes from a 1/4 note to an 1/8th note and the tempo is 
doubled, the graph line will remain constant just as the sound 
of the music does. A good example of this would be a piece 
that changes back and forth from 214 to 6/8 time where the 
beat value might change but the tempo stays the same. 

looping 

Tempo changes can be made with the pencil icon in this 
window and undone with the eraser. Tempo values will 
always be displayed at each measure boundary. A tempo 
change that occurs exactly on a measure boundary cannot 
be erased but can be changed again with the pencil. 

Individual tracks can be looped during playback. This feature 
is especially useful with short repeating sections such as bass 
or drum parts. 

Record the part once, and then edit if necessary. You can trim 
your loops using the Cut command to get the the proper 
number of measures to loop. A track ends where there are no 
more filled or hollow measures present in the SonQ Editor. For 
reference, the grey vertical bar m the Song Editor mdicates 
the end of the conductor track. 
Turn on the track's loop control and let the part play back. Lay 
down other parts or even other loops against it by recording 
on other tracks. 

Remember that the loop is only stored in memory once, and 
always starts at the beginning of the sequence. That means if 
you start playback past the point of the loop, the track will not 
playback. That also means if you are copymg tracks from one 
sequence to another it may not be possible to preserve the 
loops that begin later in the piece. This is the reason to create 
literal copies of your loops, especially before building songs. 

Loops encourage speed and spontaneity in music making 
and also save memory. Use them to work out your ideas. 
However, once your song or song section is complete, copy 
and paste the looped part into the track so that it fills out to the 
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end of the sequence. This will give you the flexibility of Master 
Tracks Pro's son~ structure. This will also let you create 
subtle variations In the loop each time it plays using the 
Change menu or other regional editing commands. 

Once you have copied your looped part you can append as 
many copies of it as you like by repeatedly selecting Paste or 
pressing Command-V. The insert point automatically moves 
to the end of the last paste. 

Master Tracks Pro's Loop feature requires you to loop to the 
nearest measure but if your phrase ends in the middle of a 
measure and you want to loop it anyway, it can be 
accomplished by re-barring the last measure of the track. 
Let's say you're working in 4/4 time but you want the track to 
loop a two and a half bar phrase. Select bar 3 (presumably 
the last bar of the track) and choose Conductor from the 
Change Menu. Click in the circle next to Set Meter and set the 
meter to 1/4 time. You will now have 4 measures with one 
beat each in them in the place of old measure #3 which had 
four beats in it. Select the last two of these new measures and 
Cut them .. Your track will now loop the way you want it to. 

You may wish to load a sequence created on another older 
computer or sequencer ( that does not support Midi Files) into 
Master Tracks Pro to take advantage of its advanced 
features. This is easily accomplished since Master Tracks can 
record incoming data on all MIDI channels simultaneously. 
You only need to make one pass, playing all tracks of the 
sequence with one track on Master Tracks Pro set to record. 
After you have transferred the sequence you can use the 
Strip Data feature to Un - merge the newly recorded track by 
channel, Pasting data from each MIDI channel onto its own 
track. To sync the two sequencers together it is 
recommended that the recording sequencer be the MIDI 
master and the playing sequencer be the MIDI slave. 

editing The Cut, Copy, Paste, Clear and Mix Data editing commands 
across perform slightly differently depending on which window you 

windows are working in. 

The Song Editor works with all data types whenever you 
perform an edit operation. You can work with notes and MIDI 
data at the same time in the Song Editor. 
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In the Step Editor, when you cut, copy, or clear, you will only 
affect the note data on all channels present. In the same way, 
when you cut, copy, or clear in a MIDI Data window, you will 
only affect the type of MIDI data in that window. 

Keep in mind, however, that the Paste and Mix commands for 
both the Step Editor and MIDI Data windows will copy all data 
in the clipboard into the sequence, no matter what type or 
types of data are included. 

This scheme lets you strip a particular type of data from a 
track using Cut or Clear in the Step Editor or MIDI Data 
Windows without affecting any of the other data in the track. 
You can also use a track's worth of data collected in the Song 
Editor and paste or mix it in the Step Editor for MIDI delay 
(see below). 

crescendos Many patches (sounds) on synthesizers and drum machines 
decrescendos respond by getting louder with increased velocity settings but 

some, like organs, do not. The MIDI Volume controller is 
controller #7. In the Controllers Window, click on the 
Controller # Box and use the arrows or the keyboard to enter 
a value of 7. You can now use the pencil icon cursor to enter 
decreasing (or increasing) values at any spacing or curve you 
like. Alternatively you can choose Continuous Data from the 
Change Menu, select the range of measures over which you 
wish the change to occur, and enter the starting and ending 
values. 

important: 

building 
songs 

Master Tracks Pro provides up to 9999 measures by 64 
tracks of literal track data in which to work provided you have 
enough memory in your comp'uter. Variations and 
combinations of two song bUIlding techniques give you many 
ways of building songs from segments without giving up the 
ability to edit or add additional tracks over the entire length of 
the song. Using these techniques make it possible to add 
variation and sweetening to repeating sections and help keep 
your song organized in a single file. 

The first method separates songs into sections within the 
same long sequence. Build a conductor template and layout 
the song structure using markers. You can begin record or 
play at any point, so you can work on whatever section you 
like at any time. Leave several blank measures between 
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sections to avoid accidentally erasing anything, and then, 
using the Cut command, remove the blank measures later 
when you've finished recording. You can copy and paste 
between sections at will and save all sections at once. 

Another method lets you build songs in a more traditional way 
by appending different files together from the disk. For 
example, you could record three separate sequences and 
save them individually on the disk in separate files called 
Intro, Verse and Chorus. Open the verse and copy it. Then 
Open the Intro and paste the Verse onto the end of it. Set 
markers if you wish and use Save as ... to save the new file. 
Call it Song. Open the Chorus file and copy it. Open the Song 
file and paste the Chorus at the end of the Verse. You will now 
have a large Song in memory based on Intro, Verse and 
Chorus which you can add to and edit further. This Song can 
also be used as part of another, longer, song. 

If you have enough memory in your Apple Ilgs, you can have 
Master Tracks Pro accompany you (or entertain you) for a list 
of songs and have precise control of the time between songs. 
Use the method described above but replace "Intro, Verse, 
and Chorus" with actual songs. Insert a few blank bars 
between each song and place markers at the beginning and 
end of each song. The markers allow you to quickly TAB from 
song to song. In performance you can also use "Pause" 
assigned to your MIDI keyboard from Keyboard Setup to let 
you pause between songs and then start up at the right 
moment. 

Master Tracks Pro stores sequences as groups of tracks and 
measures along with a separate conductor track. The 
conductor track determines how data is stored, displayed and 
played back based on the meter, beat and tempo values 
stored with each measure. Storing data in measures is not 
required for MIDI sequencing but becomes more important 
when you begin to provide sophisticated graphic editing 
operations as those found in Master Tracks Pro, and when 
you desire to convert your MIDI sequences to music notation 
(more about this later). 

Ties are a special case of MIDI data and may cause problems 
for you when you cut and paste across tied notes. Some MIDI 
events are single events such as Program Change #7 or 
Sustain Pedal On. Because notes have a certain duration 
between note on and note off and Master Tracks Pro stores 
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delaying 
a track 

sliding tracks 

MIDI delay 
(echo) 

Song Pointer 
(internal sync) 

MIDI Sync 

notes in groups of measures, notes that tie across measure 
"boundarys" are stored internally as notes tied to one another, 
just as you would with music notation. When you cut across 
ties (not usually recommended) the ties will automatically be 
clipped with note on or note off events added so that no notes 
hang in the sequence or on the clipboard. 

You can delay a track by individual clock ticks (there are 48 
clock ticks per quarter note) by first Cutting or Copying the 
track in the Song editor. Then paste the clipboard into a blank 
track using the Step Editor, selectinQ the amount of MIDI 
delay by positioning the insertion pomt with the Arrow cursor. 
This will delay all the MIDI data including notes in the track by 
the number of clock ticks or beats corresponding to your 
insertion point. 

Another way to produce MIDI delay or even MIDI PRE- Delay 
is with the slide notes feature in the Quantize Dialog Box from 
the Change Menu. You can experiment with different values 
for the number of clocks until you get something that does the 
job. If you wish to offset start times without quantizing, click in 
the quantize box to remove the "x" in it. 

MIDI delay (echo) can be used to "fatten up" a track's sound 
by playing two tracks together to separate channels slightly 
offset. More radical delays or offsets can be achieved using 
the song editor to delay tracks by measures using cut and 
paste. Rounds or echoing effects can be easily done and 
undone until you have something you like. 

Master Tracks Pro generates its own internal time base when 
sync is set to Internal in MIDI Setup using a resolution of 48 
clock ticks per quarter note. It will send out MIDI timing 
messages, including Song Pointer, Start, Continue, MIDI 
clocks, and Stop corresponding to the Transport activity. For 
example, whenever you move the Transport to a new location 
in the sequence, a corresponding MIDI Song Pointer 
message is sent out. 

If Sync is set to MIDI in the MIDI Setup, the program accepts 
the timebase reference from an external MIDI source and 
interpolates 48 clocks per quarter note based on the 
incoming MIDI clock rate. It will receive and auto locate to MIDI 
Song Pointer when in MIDI Sync mode. 
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Using MIDI Sync mode with an external SMPTE-to-MIDI sync 
device such as Roland SBX-80, Fostex 4050, Garfield Master 
Beat, Cooper PPS-1 and others, you can sync Master Tracks 
Pro to SMPTE. Connect the MIDI out of the external sync box 
to the MIDI in of your Apple figs MIDI interface and connect 
the interface to either the Modem port or the Printer port. 
Select MIDI Setup from the Goodies Menu and configure the 
setup so it matches your interface connections. You can now 
record new tracks while Master Tracks Pro runs in sync with 
your SMPTE striped video or audio tape. 

If your external sync box supports MIDI Song Pointer, Master 
Tracks Pro will "chase" the tape transport and start anywhere 
in the piece. 

If your external sync box has Tempo Mapping capability, you 
can create a tempo map that duplicates your conductor track 
settings. 

Master Tracks Pro's Strip Data feature makes this easy. You'll 
need to know what MIDI note numbers the two drum 
machines each respond to. You can learn this from the 
owners manual or by playing each machine with Jour MIDI 
keyboard (using Thru on Master Tracks Pro) unti you have 
noted which key corresponds to which drum. Let's take a 
Yamaha RX snare #1 and convert it to a Roland 707 snare #1. 
First, we strip the snare out of the Yamaha drum track by 
clicking the box next to "Notes" and the circle next to "Only 
notes between" in the Strip Data dialog box from the Change 
Menu and en~ring E2 (the note assigned to Yamaha's snare 
#1) in both note value boxes. Choose Cut if you wish to 
remove the snare permanently from the drum track and Copy 
if you want to leave it in. Place the cursor on bar #1 of an 
empty track and Paste. Select the entire new track and 
choose Transpose from the Change Menu. In the first note 
value box enter E2 (from your MIDI keyboard or the Apple 
figs) and in the second box, enter D1 (Roland's note 
assignment for snare #1). Do this with each drum to complete 
the transition. You can then Mix back down to one track if you 
wish or keep independent control of each drum for further 
editing. 
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Master Tracks Pro has 64 tracks on which to record. Most 
people use only 16 to 30 of them most of the time. This leaves 
a lot of empty space that can be used for making notes about 
your work. Just scroll down to an unused area in the 
Sequencer Window, click in a Track Name field and jot down 
whatever you like, perhaps information about the patches 
used or other production notes. 

The memory window (selected from the Goodies menu) tells 
you how much memory your score takes up, how much 
memory is being used by the clipboard and how much 
memory is available for more notes. You can clear the 
clipboard memory by copying or cutting a blank measure. 
This frees up additional memory for the score. 

Trying to grab or double-click small (short) notes can be 
difficult even when you're zoomed all the way in. ( For 
instance some drum machines send notes of only 1 tick 
duration) To help you edit, you can select the region the 
note(s) fall in and use "Change Duration" (from the Change 
menu) and lengthen the note(s). This makes the notes easier 
to grab or double-click. After you do your editing, you can then 
change the duration(s) back. 
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SUMMARY OF I:SEYBOARD COMMANDS 

Space Bar 
Return or 
Enter Key 
Tab Key 
Shift-Tab 

Right Arrow 
Delete 

Left Arrow 

#3 - 0 
+ -, 

Command -1 
Command - 2 
Command - 3 
Command - 4 
Command - 5 
Command - 6 
Command -7 
Command - 8 
Command - 9 
Command - 0 

Command - N 
Command - 0 
Command - S 
Command - Q 
Command -I 

TRANSPQRT COMMANDS 

Start and Stop Transport 

Record 
Move to next Marker 
Move to previous Marker 

GENERAL QQMMANDS 

Enters a rest in Step Entry mode 
Clears selected area in Song ,Step, and 
Midi Data Windows. 
Deletes last note entered in Step Entry 
Mode. 
Change measure ruler display values 
Change numbering from odd to even 
display 

WINDQW QOMMANDS 

Track Sheet Window 
Song Editor Window 
Step Editor Window 
Pitch Bend Window 
Channel Pressure (Aftertouch) Window 
Key Pressure (Polyphonic) Window 
Modulation Window 
Controller Window (all other Controllers) 
Program Change Window 
Conductor Track Edit Window 

FILE QQMMANDS 

Start with new sequence 
Open sequence from disk 
Save current sequence to disk 
Quit Master Tracks ProTM 
Insert Measure 

14-9 
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Command - Z 
Command - X 
Command - C 
Command - V 
Command - M 
Command -I 
Command -A 

Control- A 
Control- Z 

Option- P 
Option - R 
Option-S 
Option - L 

Command -[ 
Command -] 

EDIT COMMANDS 

Undo last edit or change operation 
Cut 
Copy 
Paste 
Mix 
Insert measure 
Select All 

Go to top of file 
Go to end of file 

STEP EDIT WINDOW COMMANDS 

Toggles Play / Mute current track 
Toggles Record On / Off current track 
Toggles Solo On / Off current track 
Toggles Loop On / Off current track 

LAYOUT COMMANDS 

Zoom In 
Zoom Out 

GOODIES COMMANDS 

Command - K Keyboard setup 
Command - R Record Filter 

In any Midi Data Window, pressing any key except Space bar, 
Return, Enter, Tab, Backspace, or Clear will toggle between a 
dotted line graph and a filled graph of any Midi data which is 
present. 
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I MOST COMMONLY USED MIDI CONTROLLERS I 

CONTROLLER #1 
CONTROLLER #2 
CONTROLLER #4 
CONTROLLER #5 
CONTROLLER #6 
CONTROLLER #7 
CONTROLLER #8 
CONTROLLER #10 
CONTROLLER #64 
CONTROLLER #65 
CONTROLLER #66 
CONTROLLER #67 
CONTROLLER #92 
CONTROLLER #93 
CONTROLLER #94 
CONTROLLER #95 
CONTROLLER #96 
CONTROLLER #97 
CONTROLLER #122 
CONTROLLER #123 
CONTROLLER #124 
CONTROLLER #125 
CONTROLLER #126 
CONTROLLER #127 

MODULATION WHEEL 
BREATH CONTROLLER 
FOOT MODULATION 
PORTAMENTO TIME 
DATA ENTRY SLIDER 
MAIN VOLUME 
BALANCE 
PAN 
SUSTAIN (DAMPER PEDAL) 
PORTAMENTO 
SOSTENUTO (MIDDLE PEDAL) 
SOFT PEDAL 
TREMELO DEPTH 
CHORUS DEPTH 
CELESTE (DETUNE) DEPTH 
PHASER DEPTH 
DATA INCREMENT 
DATA DECREMENT 
LOCAL CONTROL (OFF=O, ON=127) 

ALL NOTES OFF 
OMNI MODE OFF 
OMNI MODE ON 
MONO MODE ON 
POLY MODE ON 
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